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Chapter 1 

 
Introduction 

 
 
 
 
Laservall Spa's Smartist 4, is an application program for the graphic creation of two dimensional objects 
for engraving with Laservall Spa laser  
 
 
 

NOTE: 
For management of external signals, controlling and entering engraving data using the Smartist 4 
program, it is necessary to install and configure the DSP interface board.  
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System requirements for Smartist 4 
• For Microsoft Windows™: Intel Pentium processor ® at 300 MHz or equivalent (500 MHz 

recommended)  
• Windows NT, Windows 2000 or Windows XP. 
• Microsoft Internet Explorer 6 
• 32 MB RAM (64 MB recommended), 
• 40 MB free hard disk space,  
• Colour monitor with 800 x 800 resolution and CD-ROM reader. 
 
NOTE: 
Smartist 4 can also be installed on Windows 98 but its functionality is limited to emulating and not 
engraving. 
 
• If laser engraving is to be effected, a Laservall Spa DSP board with relative driver must be 

installed. 
 

Smartist 4 Installation 
 
The Smartist 4 program must be installed on a PC with 800 x 600 or higher resolution color monitor. 
 
Follow the procedure described for installing Smartist 4 on a Windows computer  
 
• Insert the Smartist 4 CD in the computer CD-ROM drive 

 
• Carry out one of the described operations: 

 
• In Windows,  

Wait for the CD auto run if it is active 
select Start > Run. Click on Browse and select the Setup.exe file on the Smartist 4 CD. Click on 
OK in the  Run window to start the installation. 
 

• Follow the prompts on the screen. 
 

• If necessary, reboot the computer. 
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Selecting the language 
 
The guided installation procedure installs Smartist 4.1 and collateral applications. One of these 
applications is called LASER CONTROL and one of its functions can be used to set the application 
language of Smartist4.  
 
Starting Smartist 4 
Select (Windows) Start > Programs > Smartist 4.1 > Laser Editor 
Or enter the folder ..\smartist4\bin  and launch the executable: Laser Editor.exe 
 
After Smartist 4.1 is started a new icon will appear (laser warning symbol on a yellow background) to 
the left of the system clock, this is the LASER CONTROL icon. 
 

 
 
Launch the Laser Control program by clicking on this icon. 
 
When started, each of the programs is configured to detect the operating system language and to 
adapt to it. If you want to set a specific language, you can select it. 
 

 
 



 

Chapter 1 10 Laservall S.p.A. 

Product Registration 
 
The software can be installed as trial version for 30 days. Before it expire, the Smartist must be 
activated with using the Activation code in the About box. 
To register Smartist 4.1: 
 
• Enter the about box: select Help > About 
• By using the mouse, select the activation code (string blue highlighted in the picture below) 
• Copy the activation code (CTRL+C) 
• Paste the activation code in an email and send it to help@laservall.com 
• The message sent will be processed and in the reply will be attached the file called Licence.dat 

that must be copied in the folder …\Smartist4.1\Bin 
 
 
 

 
 

mailto:help@laservall.com
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Smartist 4 Innovations 
 
Smartist 4.1 represents a continuation of the development undertaken with the previous program 
Smartist 4. 
 
The new features in Smartist 4.1 offer advanced function for creating engraving projects, simplified 
work flow used to create single projects able to integrate vectorial graph models or bitmap models and 
associate axis control mechanisms or engraving sequences to them.   
 
Smartist 4.1 also includes significantly expanded functions for the creation of actions with Visual Basic 
Script, integrating Active Script technology.  
See the “VB Script” chapter in this manual. 
 

The new Smartist 4.1 features 
 
• New LASER CONTROL program 
• Enhancement of Vbscript, new objects and methods 
• New grouping functions and object intersection 
• DXF and PLT import filter dialog window 
• Enhancement of DXF import filter 
• Simplified management of the I/O masks for “Receive and Send” and “configure Outputs” functions 
• New algorithm for engraving bitmaps in shades of grey 
• Management of three types of laser (diode pumped, lamp pumped and CO2) from LASER 

CONTROL 
• New LASER TUNE for optical correction on the plane 
• New EVENT project function 
• New possibility of setting a default template project 
 
 
 
 



 
 
 
 
 
 
 
 
 
 

 
Chapter 2  

 
Basic Concepts 
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Overview 
The Smartist 4 program makes it possible to generate graphic files and translate them into paths for 
laser engraving. The laser engraving system consists of: 
 
1) DSP  board to be connected to a standard or industrial PC slot 
2) DSP board driver. 
3) DSP control program for tuning engraving parameters. 
4) Graphic editor for drawing models to be sent to the engraver.. 
 
The complete system components hierarchy is illustrated in the following chart 
 
 

 
 
The engraving file is graphically created by Smartist 4, a program for creating bitmap models, 
photographic marking and vectorial models, consisting of: 
 
• Text strings. 
• Customized date and time. 
• Counter. 
• Barcodes. 
• Data matrix. 
• Vectorial Drawings (VCT, PLT, DXF).  
• Bitmap Drawings (BMP, JPG, GIF) 
 
The DSP board program manages up to three linear mechanical axes and one rotating mechanical 
axe. 
 
Smartist 4 can be used to create graphic models for laser engraving with Laservall DSP engraving 
systems. The program has two separate operating modes: 
 
• Work mode.  This mode is for working only. In other words, the loaded model cannot be edited in 

any way. In this mode, the program automatically updates the "active" components (for example 
the date or the counter) at each engraving job beginning and end.. 
The work mode can be blocked by a password. 

 
• Edit mode. This mode is used for creating/editing vectorial graph models (text strings, bar codes, 

data matrix, CAD files, etc.) and bitmap models (Windows BMP) and either sending the models to 
the engraver or saving them on the disk. 

 

 
Control program 
(Laser Control) 

Driver 

DSP board 

Smartist 4 
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Creating a new project 
 
When creating a new work, with Smartist 4  the type of work to be effected is set from a selection 
window. 
To create a new work select File> New. 
After selecting the command, the PROJECT ROOT will appear where you can place a new engraving 
plane or engraving on rotor and organise a new project. 
The engraving project is able to group vectorial, Bitmap, and rotating axe engraving, in addition for 
each object it is possible to associate movements of mechanical axes and activation from remote 
signals, Input and output logic signal control. 
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Creating a new project for plane engraving 
When working with Smartist 4, a project is created composed of new graphic forms for engraving and 
organized with any elementary functions for completing the activity required by the application. 
Creating or editing  a project is only from: 
 
• Mode > work mode 
 
To create a new project to use for engraving a flat surface: 
• Select File > New 
• Enter a new plane in the Root of Project > Add Plain 
A new window 1 will open corresponding to the engraving laser work area 
In work window 1 it is possible to draw the graphic to be engraved or import a drawing if the extension 
is compatible with  Smartist 4 (DXF, PLT, BMP), see the chapter on exporting files for additional 
information. 
 

 
 
1 Work area 
2 Tool bar with tools for drawing and managing the project 
3 Menu with all Smartist 4 commands 
4 Property window. This changes depending on the type of operation required 
5 Project pages. See relative chapter 
 
NOTE: 
The size of the work area is a fundamental parameter. The maximum size that can be used is based 
on the focus height installed on the engraving laser. 
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Focus length 
 
The maximum width of the work area is defined by the focus length set in Laser Control. 
 

 
 
 
• Open the Laser Control application by clicking twice on icon 1 in the Tray area  
• Select the Correction page  
• Open Combo Box 2 and set the focus length used by the engraving laser 
 
NOTE: 
it is important that the selected focus length actually corresponds to the one installed on the engraving 
laser 
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Creating a new project for ring work engraving 
As previously described for plane surface engraving, when working with Smartist 4 a project is created 
composed of new graphic forms for engraving and organized with any elementary functions for 
completing the activity required by the application. Creating and editing a project is only from: 
 
• Mode > edit mode 
 
To create a new project for rotary axis engraving 
• Select File > New 
• Enter a new plane in the Root of Project > Add Ring work 
• A new window 1 will open corresponding to the engraving laser work area 
 
In work window 1 it is possible to draw the graphic to be engraved or import a drawing if the extension 
is compatible with  Smartist 4 (DXF, PLT, BMP), see the chapter on exporting files for additional 
information. 
 

 
 

1. Model with preset size based on the linear development of the surface to engrave 
2. Tool bar with tools for drawing and managing the project 
3. Menu with all Smartist 4 commands 
4. Property window. This changes depending on the type of operation required 
5. Project page, TAB. See relative chapter. 

NOTE: 
The height and diameter of the work area is a fundamental parameter. The displayed work area is the 
development of the surface to be engraved. 
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Drawing with Smartist 4 
 
Two dimensional graphics generated by other programs (Audocad, Corel, Macromedia, Adobe…) can 
be imported in the Smartist model. 
The following are Smartist 4 importation files: 
 
• DXF:  is a two dimensional vectorial graphic exchange format primarily used by CAD applications, 

but available for most vectorial graphic applications on the market. 
 

• PLT:  is a vectorial format used as an exchange file for plotters. The filters that are equipped with 
vectorial graphic programs can be used to generate it, or by installing HP model 7475A plotter in 
the operating system and printing the graphic created with the application on the file. 
 

• BMP: is the standard format for bitmap graphics. It can be generated with any graphic application, 
from digital cameras or scanners. 
 

• DIB: Device Independent Bitmap, is a format similar to BMP. It can be generated with any 
graphic application, from digital cameras or scanners. 
 

• JPG: is one of the most common compressed bitmap formats. A BMP image converted into JPG 
has a much smaller (in bytes) dimension, it is generally used in continuous tone images.  
 

• GIF: is a format similar to BMP. It can be generated with any graphic application, from digital 
cameras or scanners. 

 
• VCT: engraving graphics generated by Smartist Pro (2.11 or lower) 

 
The imported graphic can be located in the model and moved, re-dimensioned, rotated and 
transformed so that it is compatible with the object to be engraved. 
 

 
 
The example in the figure shows a drawing imported into a Smartist 4 model and then re-dimensioned 
and rotated to adapt it to the object to be engraved.



 

Laservall S.p.A. 19 Chapter 2 

 

Importing graphics with Smartist 4 
 
After having created a new project as described in the previous chapters, it is possible to import a 
drawing as follows: 
 
• Select: Actions > Add > Import File 
 
The following window will be displayed 
 
• Select the importation filter from the "File type" combo box.  
• Specify the path of the file to be imported from the “search” combo box 
• Select the file. 
 

 
After having positioned the file inside the work area, elementary operations can be effected, for 
example: 
 
• positioning the object on established coordinates 
• changing the height and width of the object 
• filling the object with filler lines (only if the lines of the imported object are closed) 
 
The drawing can be completed by adding other imported graphics or with Smartist 4 entities, for 
example: 
 
• Text strings  
• Bar codes 
• Data matrix 
• Connected objects (LDX) 
 
NOTE: 
The use of LDX connected objects is described in the following chapters. 
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Information on bitmap and vectorial graphics 
 
Computers display vectorial or bitmap graphic formats. Understanding the difference between the two 
can be helpful for working more efficiently. 
Smartist 4 is able to generate and import two dimensional vectorial graphics and also import and edit 
bitmap graphics created in other applications. 
 

Vectorial graphics 
Vectorial graphics describe the images using lines and curves, called vectors, which all include 
properties related to color and position. For example the image of a feather is described by points 
through which lines pass, creating the form of the outline of a leaf. The color of the leaf is determined 
by the color of the outline and the color enclosed within the outline. In the example described below a 
black and white feather is represented because the laser engraving is monochromatic. When vectorial 
graphics are edited, all the properties of the lines and curves which describe the form are also edited. 
It is possible to move, re-dimension, remodel and change the color of vectorial graphics without 
changing their quality. Vectorial graphics are not resolution dependent, this means they can be 
displayed on output devices with different resolutions with no change in quality. 
 
 
 
 

 
 
 
 
 
In laser engraving a vectorial graphic is faster in engraving and more defined in terms of outline lines 
and filling. A vectorial graphic cannot be used for engraving digital photographs. 
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Bitmap graphics 
Bitmap graphics describe images using colored dots, called Pixels, located within a grid. For example, 
the image of a feather is described by the specific position and color of every pixel in the grid, the 
creation process is very similar to that of a mosaic. 
In the example described below a black and white feather is represented because the laser engraving 
is monochromatic 
When bitmap graphics are edited the pixels are edited instead of the lines and curves. The bitmap 
graphics change with resolution, as the data which describes the image is fixed in a grid with specific 
dimensions. Editing bitmap graphics can change their quality. In particular, re-dimensioning bitmap 
graphics may make the edges of the image irregular since the pixels within the grid are redistributed. 
In addition, displaying bitmap graphics on an output device with a lower resolution in relation to the 
image reduces the display quality. 
 

 
 
 
In laser engraving, a bitmap graphic is slower in engraving and less defined in terms of outline lines 
and filling. A bitmap graphic can be used, with opportune conversions, for engraving digital 
photographs. 
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Smartist 4 work environment 
 
During the creation and editing of projects for engraving, normally the following key functions are used 
 
• The graphic work area where the drawing is represented 
• The project work area where any sequences and functions are displayed within the individual 

project 
• Property window, where the engraving parameters and properties for the single graphic objects are 

set 
• Simulation for displaying a new window with the outline of what the laser is going to effect in the 

engraving area 
• The toolbar for editing the various project and drawing elements.. 
 
 
 

Zooming reducing 
 
By changing the zoom, it is possible to display the whole graphic area on the screen or a greatly 
enlarged detail of a particular part. The maximum zoom depends on the screen resolution and the 
dimensions of the graphic area. 
The zoom or reduce use the following techniques: 
 
• To zoom a certain element, select the Zoom tool and click on the element.  
 
• To zoom a specific area in the drawing, use the zoom to trace a rectangular window around the 

perimeter. Smartist 4 sets the zoom level so that the specific rectangle fills the window.. 
• Or select Zoom > Window 
 
• To zoom or reduce the entire window, select Zoom > In or Zoom > Out. 
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Property window 

Project property 
The parameters which characterize the various elements or the functions which make them up are set 
in the project property window. Each project component will be described in chapter 6: Framework of 
a Project 

Engraving document property 
The property window changes based on the type of engraving document selected. The engraving 
document can be "flat" for vectorial or bitmap graphic engraving on flat surfaces, or "rotor" for vectorial 
or bitmap graphic engraving on rotating axes. 
 
General 
The grid characteristics are set on the "General" page 
 

 
Snap to grid:   Enables the snap to the objects in the grid 
Grid:   Enables grid display 
Size:   Sets grid spacing 
 
Flat 
The characteristics for objects engraved on flat surfaces are set on the "Plain Work" page.  

 
Work area  Width/Height:  Sets the dimension of the work area 
Margins  X Y   Sets the width of the margins in the work area 
Print Area Width/Height  Sets the maximum width of the work area, it is related to the 

   lens mounted on the engraving laser 
Plain Z position  
Height     Shows the Z axe value set in the laser parameters, it can be 
      editing by enabling "Enable" and entering a new value in the  
      "Height" field
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Ring 
The characteristics for graphic objects to be engraved on rotating axes are set on the "Ring Work" 
page. 

 
 
Standard Parameters 
Diameter: The size of the external or internal diameter, expressed in millimeters.  
Height:  The height of the ring or cylinder, expressed in millimeters 
Margins:  Sets the width of the margins in the work area 
Engrave : Sets engraving inside or outside the ring 
 
Advanced Sets 
Sector Size:  Defines the width of the sector in millimeters, The sector represents a  

graphic portion to be engraved. Figure 1 shows an engraving without 
sectors (sector= 0), the graphic elements (for example the letters in the  
word laservall) are engraved individually, after each engraving the motor 
of the separator advances. In figure 2 a sector value greater than 0 has  
been set (the size of the sector is based on the size of the ring). Engraving  
is organized by sectors reducing the number of motor movements. 
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NOTE: 
the sector Size value is self-controlled by Smartist 4 program to prevent distortions in the engraving 
caused by curving of the ring.  
 
 
Angle     The slant angle of the work-piece on the separator,  

expressed in degrees 
Reset axes at engraving end  If enabled, it brings the rotor to its initial position at the  

end of engraving 
Use radius as Z position:   Smartist 4 can be used to automatically focus the ring to be 

engraved by enabling the term "Use radius  as Z position”. 
When this function is enabled Smartist 4 will compute the 
optimum focus position according to the diameter (internal or 
external) entered in the respective box. 
For correct operation of this option, set the logic zero of axis 
Z in the revolution center. Logic zero is the focus position on 
the item to be engraved. 

 

 
 
Position Z Enable/Height  The R axe value. It can be edited using "Enable", set 

the new value in "Height" 
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Graphic object property 
Each object that makes up the model can be edited using the mouse, toolbar or "property window" 
which displays all the characteristic parameters including: sizes, origins, filling, laser parameters etc. It 
is important to note that also the document itself is an object which properties can be accessed when 
no other object is selected. Each graphic object uses by default the laser parameters of the document. 
You can set different laser parameters for each object, in this case, the parameters will appear blue. 
 
Object properties depend on the selected object, this is discussed in the paragraphs related to 
individual graphics (text, bar codes and data matrix). 
 
 

Setting the measurement unit 
 
Smartist 4 makes it possible to set the linear measurement unit which characterizes part of the 
configurations. You can use the "General" page located in the project property window and set the 
measurement unit in millimeters or inches from the "Measurement unit" menu. 
 

 
 
Resolution 
Linear  Represents the approximation  for linear quotes. Each entered measurement unit will be 

approximated to the value set in this box 
Angle Represents the approximation  for angle quotes. Each entered measurement unit in degrees 

will be approximated to the value set in this box 
Relative Represents the approximation for relatives, that is expressed in percentages. Each entered 

percentage value will be approximated to the value set in this box. 
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Coloring of graphic objects 
The objects in the graphic area may be different colors. 
 
• Black: 

Black indicates that the object is correctly placed within the graphic area and is enabled for 
engraving. Its engraving parameters are the standard ones of the document.. 

• Blue: 
Blue indicates that the graphic object is correctly placed within the graphic area and is enabled for 
engraving. Its engraving parameters are NOT the standard ones of the document, special laser 
engraving parameters have been set which are only relative to the blue colored object. 

 
NOTE: 
There can be various blue colored objects within the graphic area. Each object had laser parameters 
which are different than the standard document ones. The blue colored objects may have laser 
parameters which are different from each other. 
 
• Red: 

Red indicates that the graphic object is NOT correctly placed within the graphic area. A red colored 
object will NOT be engraved. 

• Grey: 
Grey indicates that the graphic object is correctly placed within the graphic area but is NOT 
enabled for engraving (see the area highlighted in the property window). A grey colored object will 
NOT be engraved. 
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Creating Graphics 
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Smartist 4 drawing tools 
 
Smartist 4 drawing tools can be divided into two different types: 
 
• Imported graphics 
• LDX connected objects 
• Smartist 4 objects 
 

Imported graphics 
 
For a description and the use of imported graphics see the description contained in the previous 
chapter. 
 
 

LDX connected objects 
For a description and the use of LDX connected objects see the description contained in the previous 
chapter. 
 

Smartist 4 objects 
Some elementary forms able to complete the engraving can be introduced into the graphic area. 
 
• Text 
• Bar Code 
• Data Matrix 
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Using the text tool 
 
When text is used in Smartist 4 it is possible to set dimensions, printing character, style, spacing, 
shear and filling. The text can also be transformed as if it were an object, by rotating it, shearing it and 
mirroring it, and it is still possible to edit the characters. 
 
It is possible to insert text boxes in the projects destined for user input or dynamically displaying 
updated texts, by associating an identification to a string. 
It is also possible to place the text inside or outside of a circumference arc. 
 
In Smartist 4 it is possible to import any kind of true type font, including Asian origin ideogram fonts. 
To for importing fonts see the paragraph in the chapter: Customizing Smartist 4. 
 
To add a text string in Smartist 4: 
 
from the menu select: “Actions”  “Add”  “Text”, or use the mouse to click on the “Add string” 
icon on the tool bar. 
Then set the text parameters: 
 
• Font style 
• Character height 
• Compression percentage 
• Spacing percentage 
• Character angle 
• Character shear 
• Circle arrangement arc radius 
• String ID 
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Special character sequences 
The text string can contain any alphanumeric character and one or more of the following special 
character sequences: 
 
%a, %A : Day of the week, abbreviated (a) or full (A) 
%b, %B : Month of the year abbreviated (b) or full (B). 
%c  : Date and time according to current location 
%d  : Day of the month, decimal number (01 –31) 
%H : Time 24 hour clock format (00 – 23) 
%I  : Time 12 hour clock format (01 – 12) 
%j  : Day of the year, decimal number (001 – 366) 
%m : Month of the year, decimal number (01 – 12) 
%M : Minutes, decimal number (00 – 59) 
%p : A.M. / P.M. indicator 
%S : Seconds, decimal number (00 – 59) 
%U  : Week of the year, decimal number (00 – 51, Sunday is the first day of the week). 
%w : Day of the week, decimal number (1 – 7, Sunday = 1) 
%W : Week of the year, decimal number (01 – 52, Monday is the first day of the week). 
%x : Date according to current location 
%X : Time according to current location 
%y  : Year, two digit decimal number (00 – 99) 
%Y : Year, four digit decimal number 
%z, %Z : Time zone, name (Z) or abbreviation (z). 
%n : Counter, decimal format 
%o : Counter, octave format. 
%e, %E : Counter, hexadecimal format, lower case (e) or upper case (E) 
%s  : Data from serial RS232-C. 
%%  : Percentage sign% 
%ID : (Percentage sign followed by an ID number) ID number string copy 
%#c  : Long date and time representation, appropriate for current locale.  
    For example: "Tuesday, March 14, 1995, 12:41:29" 
%#x  : Long date representation, appropriate to current locale.  
    For example: "Tuesday, March 14, 1995" 
 
 
1 The string ID is a number which identifies the string univocally inside the file. 

Example of date in dd/mm/yyyy format 
Proceed as follows to make a text string with the format: day (two digits), month (two digits), year (four 
digits) separated by ‘/’: 
• Create a text string. 
• Select the required parameters (font, character height etc.) 
• Enter the string “%d/%m/%Y” in the text box and press enter 
 

Example of date in dd/mm/yy format 
Proceed as follows to make a text string with the format: day (two digits), month (two digits), year (two 
digits) separated by ‘/’: 
• Create a text string. 
• Select the required parameters (font, character height etc.) 
• Enter the string “%d/%m/%y” in the text box and press enter 
 
NOTE: 
%#a, %#A, %#b, %#B, %#p, %#X, %#z, %#Z, %#%  
# flag is ignored 
%#d, %#H, %#I, %#j, %#m, %#M, %#S, %#U, %#w, %#W, %#y, %#Y  
Remove leading zeros (if any) 
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Alphanumeric ID 
 
To each object loaded in the graphic area can be assigned an alphanumeric ID, as described in the 
picture below. 
 

 
 
The ID can be used to copy the contents on other text object (or barcode or Datamatrix) present in 
different Plain. 
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Example of counter 
Proceed as follows to make a text string including a decimal format counter: 
 
• Create a text string. 
• Select the required parameters (font, character height etc.) 
• Select the required counter parameters (see below). 
• Enter the string “%n” in the text box and press enter. 
 

 
The counter parameters can be accessed from the "Properties" 
window on the string "Data" page> The parameters are: 
 

• Start, the minimum value of the counter. 
• Stop, the maximum value of the counter 
• Cycles, the number of engraving jobs required to 

increase 
       the counter. 

• Increment, increment value (positive or negative). 
• Digits, minimum number of digits to be displayed. 

 
 
 
 
 
 
 

 
 
For example, with the following parameters:  
 
Current   = 9 
Start  = 1 
Stop   = 10 
Cycles  = 2 
Increment            = 2 
Digits  = 3 
 
The following would appear: “001” 
to become: “003”…”005”…”007”…”009”…”002”…”004”…”006”…”008”…”010”…”001”… 
 
In this example an increment would occur every two engraving jobs. 
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Selecting text properties 
The property window displays the text parameters only when the text in the graphic area is selected. 
Typical text parameters are shown on the various pages in the figure. 
 
General: 
 
Main: 
Enable:  Enables engraving of the selected text (if not 

enabled the text is gray) 
Position XY Sets the text coordinates in relation to the 

origin of the engraving area (0,0 is the center 
of the area) 

Width, Height: Sets the text width, height 
Maintain Aspect: If enabled, keeps the proportions between 

width and height 
Angle  Sets the rotation angle (in degrees) of the  

string on the engraving area 
Shear X   Sets a shear on axis  X. The shear in the  

figure on the right is 50. 

Shear Y  Sets a shear on axis  Y. The shear in the  
figure on the right is 50. 

. 
Origin: 
Position This is used to move the reference origin of 

the string. The origin is identified by an X 
placed in the center, this can be moved to one 
of the four corners of the selected object. 

 
Filling: 
Type of Filling This is used to fill the text string. 

Filling can be done with: 
single lines 
Double crossed lines 
Triple crossed lines 

Fill Option This represents the filling procedure to use for engraving bar codes, it can be  
monodirectional or bidirectional 

Fill angle… Represents the fill angle 
Fill space… Represents the fill line space 
Not engrave path:If this option is selected, only filling lines will be engraved. 
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Clone Object 
 
Enable This is enabled in order to generate clones of the selected object. Clones are objects 

which are identical to the original one, placed on a rectangular matrix. Editing of the 
original object parameters (in black) is reflected on its clones (in green) 

Clone in X Represents the number of clones on the horizontal axis (X) 
Clone in Y Represents the number of clones on the vertical axis (Y) 
Offset X  Represents the offset of the clones on the X axis in relation to the original 
Offset Y  Represents the offset of the clones on the Y axis in relation to the original 
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Text 
Data: 
Text: Enter the string to be engraved in the TEXT field;  

or the value of the variable which represents it 
ID:  Represents the numeric value which univocally 

identifies the string or variable 
Style 
Font:  Represents the converted True Type font that the 

text must use 
Height:  Represents the character height 
Shear:  Represents the shear of the selected character on  

the X axis 
Angle Represents the angle of rotation that a single letter 

uses in relation to its origin. The example shows a 
string with a character angle of 45 degrees. 

 
 

String Displacement 
Space Represents the spacing between the letters of the 

string (default value is 100).  
The example below shows a string with a spacing 
value of 200. 

 
Compression Represents the compression of each character of the string (default value is 100).  

The example below shows a string with a Compression value of 200. 

 
Circle Displacement 
 
Enable Enables placing the text on the circumference arc 
 
Radius Represents a hypothetical circumference arc to align the string on.  

The example below shows a string with an arc of 20 mm. 
 
Auto start angle If enables, this is used to set the start point of the string on the arc. The start point is 

set in degrees in the "Start Angle" field. The figure shows an automatic start angle. 
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Data: 
 

 
Main data 
Text: Enter the string to be engraved in the TEXT field;  

or the value of the variable which represents it 
ID:  Represents the numeric value which univocally identifies the object in the 

document 
 
Counter 
 
Start:   minimum value of the counter. 
Stop:  maximum value of the counter. 
Step:  value of the increment (positive or negative).. 
Cycles:  number of engraving jobs required to increase the counter. 
Digits:  minimum number of digits to be displayed. 
 
 
NOTE: 
The counter is only enabled if the sequence %n appears at least once in the TEXT box 
 
Customized formatting 
Enable:   Enables management of VB script (see relative chapter) 
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Adding a bar code 
A bar code can be defined as a symbol or alphabet for coding information in a format so that it can be 
automatically acquired. 
 

Terminology 
 
Bar code A succession of alternating dark elements (bars) and blank elements 

(spaces) Code may also mean the type of coding. 
 

Element   Name of a space or a bar 
 
Bar   Dark element of  a code 
 
Space   Blank element between two bars 
 
Bar code symbol  A complete bar code, made of a blank area before the code, a start 

character, one or more characters containing the information, a stop 
character and a final blank area. 

 
Discrete code Bar code in which all elements are not significant. Some act as separators, 

relatively broad tolerances are allowed for their thickness. 
 

Continual code   The bars and spaces which contain information. 
 
Inter-character space A space which separates two adjacent characters, in some codes (code 39, 

bar code) the spaces inside a character contain information, inter-character 
spaces do not. 

 
Module   The smallest thickness in a code element. It constitutes the measurement  

unit of the thickness of wide elements. 
 
Character  Succession of bars and spaces which code a single decimal digit or a  

special alphabet character. 
 

Start/Stop Character Each symbol starts with a start character and stops with a stop  
character. They are used to identify the type of code and   
indicate the reading direction 

 
Quite Zone The blank spaces immediately preceding the start character and following 

the stop character. 
 

Print ratio  In two thickness codes, it is the ratio between the thickness of the wide  
element and that of the narrow one 
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When a bar code is used in Smartist 4 it is possible to set the dimensions, the type of standard, a 
checksum, the shear and filling.  
 
The following bar codes are available: 
 
• 2/5 Standard 
• 2/5 Industrial 
• 2/5 Interleaved 
• 3/9 Standard 
• 3/9 Full 
• Code 128 
• EAN 13 digit 
• EAN 8 digit 
• UPC-A 
• UPC-E 
 
The bar code is treated by Smartist 4 in the same way as a text string, therefore it is possible to 
associate the functions of special character Sequences described in the previous paragraphs. 
 
Bar code engraving can be done in reverse by enabling the relative tag. 
 
NOTE: 
Reverse bar code engraving can only be done on those materials which react "backwards". The bar 
code standard does not include reverse coding. 
 

Classifications 
 
Two thickness codes 
The code elements (bars and spaces) can only assume two thickness, in a ration between 2 and 3. 
The following codes belong to this group: 
 
• 2/5 Standard 
• 2/5 Industrial 
• 2/5 Interleved 
• 3/9 Standard 
• 3/9 Full 
• Code 128 
 
Codes with multiple thicknesses  
The code elements can assume more than two different thickness. Generally this requires better 
printing quality. The following codes belong to this category: 
 
• EAN 13 digit 
• EAN 8 digit 
• UPC-A 
• UPC-E 
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Structure of a bar code symbol 
 
A bar code symbol is made up of a series of bars and spaces which contain information and check 
elements. 
 

 
 
Y: Thickness of the wide element 
X: Thickness of the narrow element 
Q: Thickness of the blank overflow zones at the end of the label (quite zones) 
 
The type of code is characterized by: 
 
 
• Ratio between the thickness of the wide elements and that of the narrow ones 
• Thickness of the narrow element. This is often called "module thickness", it is used as the 

measurement unit of the wide element thicknesses. 
• Sequence of bars and spaces for coding the characters which can be represented. The single 

characters are codes with 4,5,7,8 or 9 elements.. 
• Characters which can be represented. All codes can represent digits, some can also code letters 

and/or special characters. 
• Number of characters which can be represented with a label. Some codes represent a fixed 

number of characters.  
• Sequence of bars and spaces for coding the start/stop characters. They are used for identifying the 

type of code and for establishing the reading direction. Some codes use the same sequence for 
both others have separate sequences.. 

• Tolerances for the single elements. Tolerances can range from a few hundredths to a few tenths of 
a millimeter. 

• Check digit. To increase the security of the code a check digit may be added to the useable 
characters. 
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 Selecting bar code properties 
 
General: 
 
Main: 
Enable:  Enables engraving of the selected text (if not 

enabled the text is gray) 
Position XY: Sets the bar code coordinates in relation to the 

origin of the engraving area (0,0 is the center of 
the area) 

Width, Height: Sets the code width, height 
Maintain Aspect: If enabled, keeps the proportions between  

width and height 
Angle:  Sets the orientation angle (in degrees) of the  

bar code on the engraving area 
 
Origin: 
Position: This is used to move the reference origin of the 

bar coda. The origin is identified by an X placed in 
the center, this can be moved to one of the four 
corners of the selected object. 

Fill: 
Type of Filling This is used to fill the text string. 

Filling can be done with: 
single lines 
Double crossed lines 
Triple crossed lines 

Fill Option This represents the filling procedure to use for 
engraving bar codes, it can be  
monodirectional or bidirectional 

Angle  Represents the angle of the fill lines 
 

Space  Represents the space between fill lines 
Not Engrave Path Disables engraving of the code outlines 
 
Clone object 
 
Enable  By enabling this it is possible to generate clones 

of the selected object. Clones 
are objects which are identical to the original one, placed on a rectangular matrix.  
Editing of the original object parameters (in black) is reflected on its clones (in green) 

Clone in X Represents the number of clones on the horizontal axis (X) 
Clone in Y Represents the number of clones on the vertical axis (Y) 
Offset X  Represents the offset of the clones on the X axis in relation to the original 
Offset Y  Represents the offset of the clones on the Y axis in relation to the original 
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Barcode 
 

 
Data: 
Text: Enter the string to be engraved in the TEXT field,  

or the value which represents it. 
ID:  Represents the numeric value which univocally identifies the string or variable. 
 
Coding 
Code:  Represents the coding type of the bar code 
Checksum: Enables a checksum calculation on the bar code string (if installed) 
 
Bar code 
Height: Represents the bar code height 
Size: Represents the width of the unit bar 
Ratio Represents the engraving offset due to the dimension of the spot laser. This 

parameter is used to balance and make the engraved square dimensions identical to 
the empty ones. 

Quite zone: Represents the extra space to the left and right of the bar code when it is inverted  
Reverse:  Bar code engraving can be effected in reverse by enabling the tag 

 
 
 
NOTE: 
Reverse bar code engraving can only be done on those materials which react "backwards". The bar 
code standard does not include reverse coding. 
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Data 
 

 
 
Main data 
Text: Enter the string to be engraved in the TEXT field,  

or the value which represents it. 
ID: Represents the numeric value which univocally identifies the string or variable that 

represents the bar code. 
 
Counter 
 
Start:   minimum value of the counter. 
Stop:  maximum value of the counter. 
Step:  value of the increment (positive or negative).. 
Cycles:  number of engraving jobs required to increase the counter. 
Digits:  minimum number of digits to be displayed. 
 
 
NOTE: 
The counter is only enabled if the sequence %n appears at least once in the TEXT box 
 
Customized formatting 
Enable:   Enables management of VB script (see relative chapter) 
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Drawing a Data Matrix, QR Code, PDF417, Code 16K 
 
The bidirectional codes are symbols representing a 2D matrix composed of quadrangular (or square) 
modules included in a perimeter defined by a pattern. 
 

Data matrix, QR Code: Terminology 
 
Pattern Perimeter that marks off the code, composed of continuous vertical and horizontal 

lines  and a mirrored dotted line. The dotted line is composed of single modules 
alternating with single spaces. 

 
Code  Represents the code of the string which is placed inside the pattern 
Module  It is a single cell, it represents a bit in the code representation. It is represented by a  

square 
Protocol  Represents the type of encoding used by Data Matrix. Smartist 4 uses the  

ECC 200 standard protocol (Reed Solomon Error Correction) 
 
When using Data Matrix with Smartist 4 it is possible to set the dimensions, the type of standard and 
any parameter modifications for optimizing engraving. 
 
The following Data Matrix codes are available: 
 
• C40 
• TEXT 
• ASCII 
• X12 
• EDIFACT 
• BASE 256 
 
The Data Matrix is treated by Smartist 4 in the same way as a text string, therefore it is possible to 
associate the functions of special character Sequences described in the previous paragraphs. 
The Data Matrix can be square or rectangular. The matrix dimensions can be automatic (based on the 
length of the string) or set by the user. 
For square Data Matrix, the matrix ranges from a minimum of 10x10 to a maximum of 48x48. For 
rectangular Data Matrix the matrix ranges from a minimum of 18x8 to a maximum of 48x16. 
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 Selecting Data Matrix properties 
 
General 
 
Main: 
Enable:  Enables engraving of the selected text (if not 

enabled the text is gray) 
Position XY: Sets the text coordinates in relation to the origin of 

the engraving area (0,0 is the center area) 
Width, Height: Sets the data matrix width, 

height 
Maintain Aspect: If enabled, keeps the proportions between 

width and height 
Angle:  Sets the rotation angle (in degrees) of the data  

matrix on the engraving area 
 
Origin: 
Position: This is used to move the reference origin of the 

data matrix. The origin is identified by an X placed 
in the center, this can be moved to one of the four 
corners of the selected object. 

Fill 
Type of Filling This is used to fill the text string. 

Filling can be done with: 
single lines 
Double crossed lines 
Triple crossed lines 

Fill Option This represents the filling procedure to use for engraving bar codes, it can be  
monodirectional or bidirectional 

Fill angle  Represents the angle of the fill lines  
Fill space  Represents the space between fill lines 
Not Engrave Path: Disables engraving of code outlines 

 
Object clone 
 
Enable  This is enabled in order to generate clones of  

the selected object. Clones are objects 
which are identical to the original placed on a  
rectangular matrix. Editing of 
the original object parameters (in black) is reflected on its clones (green) 

Clone in X Represents the number of clones on the horizontal axis (X) 
Clone in Y Represents the number of clones on the vertical axis (Y) 
Offset X  Represents the offset of the clones on the X axis in relation to the original 
Offset Y  Represents the offset of the clones on the Y axis in relation to the original 
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Datamatrix 
 

 
Data: 
Text: Enter the string to be engraved in the TEXT field,  

or the value which represents it. 
ID: Represents the numeric value which univocally identifies the string or variable that 

represents the bar code. 
 
Encode 
Code:  Represents the type of data matrix encoding 
Size: Sets the data matrix. For square Data Matrix, the matrix ranges from a minimum of 

10x10 to a maximum of 48x48. For rectangular Data Matrix the matrix ranges from a 
minimum of 18x8 to a maximum of 48x16 

 
Datamatrix Module 
Module Size : Represents the dimension of the Data Matrix pixel in the engraving area. 
Module Ratio: Represents the engraving offset due to the dimension of the spot laser. This 

parameter is used for balancing and for making the dimensions of the 
engraved squares identical to the empty ones and is particularly useful for 
engraving very small Data Matrix. Module ratio is expressed in percentage, 
the figure below shows a Data Matrix with a module ratio of 100% (left) and 
the same Data Matrix with a module ratio equal to 50% (right). The lesser 
dimension of the engraving area (black) is used to compensate the 
dimension of the spot laser.  
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Quite Zone: Represents the extra space around the Data Matrix when it is inverted  
 
Reverse:  Data Matrix engraving can be reversed by enabling the relative tag (reverse).  

The figure below shows a normal Data Matrix (left) and a reversed Data Matrix  
(right). 

 
 
Data 
 

 
 
Main 
Text: Enter the data matrix text to be engraved in the TEXT field,  

or the value of the variable which represents it. 
ID: Represents the numeric value which univocally identifies the string or variable that 

represents the data matrix. 
 
Counter 
 
Start:   minimum value of the counter. 
Stop:  maximum value of the counter. 
Step:  value of the increment (positive or negative).. 
Cycles:  number of engraving jobs required to increase the counter. 
Digits:  minimum number of digits to be displayed. 
 
 
NOTE: 
The counter is only enabled if the sequence n is set in the TEXT box with the % symbol before it. 
 
Customized formatting 
Enable:   Enables management of VB script (see relative chapter) 
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Deleting 
To delete an object from the engraving area select it and press the button on the tool bar. 
Or select the Eliminate command from the Actions menu. 
 



 
 
 
 
 
 
 
 
 
 

 
Chapter 4 

 
Importing images 
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Adding images to SMRT4 
Bi-dimensional graphics generated by other programs (Autocad, Corel, Macromedia, Adobe…) can be 
imported into the Smartist 4 work area. They can be composed of vectorial graphics or Bitmap. 
 

Importing vectorial graphics 
The following vectorial graphics can be imported in Smartist 4: 
 
• DXF:  is a two dimensional vectorial graphic exchange format primarily used by CAD applications, 

but available for most vectorial graphic applications on the market. 
 

• PLT:  is a vectorial format used as an exchange file for plotters. The filters that are equipped with 
vectorial graphic programs can be used to generate it, or by installing HP model 7475A plotter in 
the operating system and printing the graphic created with the application on the file. 
 

• VCT: engraving graphics generated by Smartist Pro (2.11 or lower) 
 

 
To import a vectorial graphic into the work area: 
 
• Select Actions > Add > Import 
• Select the importation filter from the “File type” combo box.  
• Specify the file path to be imported in the “search in” combo box 
• Select the file. 
 
After positioning the file in the work area, the object parameters can be set. 
 
 
NOTE: 
To import these files in some cases it may be necessary to first refresh the file. 
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Vectorial import filters 
The import filters are used to import graphic objects created with applications other than Smartist 4.1. 
The import filter has parameters which the operator can set in the “Dialog Box” 
The following vectorial import filters are available in Smartist 4.1: PLT and DXF 
 

 
 
The following parameters can be set: 
• Resolution:  

parameter which sets curve resolution as a percentage. 
• Quality: 

A generic parameter which acts on the number of vector nodes. When the quality is decreased the 
number of nodes which define the polygons is decreased 

• Polygon reduction: 
Post processing operation (after importing) to reduce the polygons of the imported figure 

• Maintaining the update: 
when this option is enabled the link to the imported object is maintained, it will be regularly updated 
when the program containing it is opened. 

Importing PLT and DXF files under Smartist 4.1 for optimum performance 
Smartist 4.1 introduces a new approach on importing vectorial (PLT and DXF) files. When the user 
imports a vectorial file, he is prompted with the importing filter mask that allows him to customize the 
importing options; this was not possible under Smartist 4.01. 
Two parameters cover an important role when seeking optimum performance in laser marking.  
The “Quality” parameter allows reducing the number of nodes defining the polygons. If quality is set to 
“Fast (Low quality)” then importing velocity speeds up. This can be useful when performing lots of 
import operation or when importing very large files.  
The “Perform polygon reduction” option enables a post-processing operation on the imported vectors. 
If the original vectorial file was properly built then this operation reforms the imported object as a group 
of vectorial objects. This operation increases import time but allows two important features of the 
imported group: 
The objects can be un-grouped and manipulated one-by-one 
When marking each object is a single entity. This causes a great difference when marking a filled 
imported object. If the object is not “polygon reduced” then the filling algorithm would generate the 
filling for the entire object. On the other hand if the object is “polygon reduced” the filling algorithm 
would generate separate fillings for separate objects. 
Smartist 4.01 settings for importing filters were equivalent to Smartist 4.1’s “Slow (High quality)” and 
“Perform polygon reduction”. When these options are enabled, laser marking under Smartist 4.1 
produces the same result as under Smartist 4.01 for both quality and time. 
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 Setting vectorial image parameters 
 
Main: 
Enable:  Enables engraving of the selected text (if not 

enabled the text is gray) 
Position XY: Sets the text coordinates in relation to the origin of 

the engraving area (0,0 is the center area) 
Width, Height: Sets the object width, 

height 
Maintain Aspect : If enabled, keeps the proportions between 

width and height 
Angle:  Sets the rotation angle (in degrees) of the object 

on the engraving area 
 
Origin: 
Position: This is used to move the reference origin of the 

object. The origin is identified by an X placed in the 
center, this can be moved to one of the four 
corners of the selected object. 

Fill 
Type of Filling This is used to fill the text string. 

Filling can be done with: 
single lines 
Double crossed lines 
Triple crossed lines 

Fill Option This represents the filling procedure to use for 
engraving bar codes, it can be  
monodirectional or bidirectional 

Fill angle  Represents the angle of the fill lines  
Fill space  Represents the space between fill lines 
Not Engrave Path: Disables engraving of graphic outlines 

 
Object clone 
 
Enable  This is enabled in order to generate clones of  

the selected object. Clones are objects 
which are identical to the original placed on a  
rectangular matrix. Editing of the original object parameters (in black) is reflected on 
its clones (green) 

Clone in X Represents the number of clones on the horizontal axis (X) 
Clone in Y Represents the number of clones on the vertical axis (Y) 
Offset X  Represents the offset of the clones on the X axis in relation to the original 
Offset Y  Represents the offset of the clones on the Y axis in relation to the original 
 
 



 

Laservall S.p.A. 53 Chapter 4 

 

Importing Bitmap graphics 
 
The following Bitmap graphics can be imported in Smartist 4: 
 
• BMP: is the standard format for bitmap graphics. It can be generated with any graphic application, 

from digital cameras or scanners 
 

• DIB: Device Independent Bitmap, is a format similar to BMP. It can be generated with any 
graphic application, from digital cameras or scanners. 
 

• JPG: is one of the most common compressed bitmap formats. A BMP image converted into JPG 
has a much smaller (in bytes) dimension, it is generally used in continuous tone images  
 

• GIF: is a format similar to BMP. It can be generated with any graphic application, from digital 
cameras or scanners 

 
To import a Bitmap graphic into the work area: 
 
• Select Actions > Add > Import 
• Select the importation filter from the “File type” combo box.  
• Specify the file path to be imported in the “search in” combo box 
• Select the file. 
 
After positioning the file in the work area, the object parameters can be set. 
 
 
NOTE: 
To import these files in some cases it may be necessary to first refresh the file. 
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 Setting Bitmap image parameters 

 
General 
 

Main: 
Enable:  Enables engraving of the selected text (if not 

enabled the text is gray) 
Position XY: Sets the text coordinates in relation to the origin of the engraving area (0,0 is the 

center area) 
Width, Height: Sets the object width,height 
Mantein Aspect: If enabled, keeps the proportions between width and height 
 
Origin: 
Position: This is used to move the reference origin of the object. The origin is identified by an 

X placed in the center, this can be moved to one of the four corners of the selected 
object. 

Object clone 
 
Enable  This is enabled in order to generate clones of  

the selected object. Clones are objects 
which are identical to the original placed on a  
rectangular matrix. Editing of 
the original object parameters (in black) is reflected on its clones (green) 

Clone in X Represents the number of clones on the horizontal axis (X) 
Clone in Y Represents the number of clones on the vertical axis (Y) 
Offset X  Represents the offset of the clones on the X axis in relation to the original 
Offset Y  Represents the offset of the clones on the Y axis in relation to the original 
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Bitmap 
 

 
 
Adjust 
Brightness: Used to adjust the brightness of an imported bitmap image 
Contrast:  Used to adjust the contrast of an imported bitmap image 
Resolution: Used to change the resolution, expressed in dots per inch 
Reverse: Engraving of the imported bitmap can be done in reverse by enabling the relative tag 

(reverse). 
 
Video Modes 
Monochrome: Converts the image to monochromatic 
Gray scale: Converts the image in dithering to gray tones 
 



 

Chapter 4 56 Laservall S.p.A. 

 

Raster import filters 
The import filters are used to import graphic objects created with applications other than Smartist 4.1. 
The import filter has parameters which the operator can set in the “Dialog Box” 
The following raster import filters are available in Smartist 4.1: 
 
• BMP 
• JPG 
• GIF 
• DIB 
 
 

 
 

 
The following parameters can be set: 
 
Resolution:  

parameter which sets the resolution of the imported bitmap and consequently sets the dimensions 
of the engraving area. 
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Operations with objects 
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Selecting objects 
Selection of graphic objects is done by direct selection using the mouse cursor our by drawing a 
window which contains them. By drawing a window it is possible to select one or more objects, to 
select more than one object by direct selection, it is necessary to hold down the SHIFT key. The 
selected object is highlighted by a square , tools for changing the selected object are on the edges of 
the object. A small "x" marks the center of the selection perimeter. 
 

To deselect an object, click on a blank area of the drawing window. 
 

Enabling/disabling an object 
Each object in the graphic area can be disabled using the relative TAG, located in the properties 
window. 

 
The "Enable" TAG disables the selected object. A disabled object is displayed in gray in the graphic 
area but will NOT be engraved. 
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Group objects 
The objects located in the graphic area can be batched so as to form a single object.  
The functions Batch Separate and Intersect of objects are used to create unusual and irregular 
shapes. They can be used on all objects. However it is not possible to batch or intersect bitmap 
pictures. 
Batch, Separate and Intersect operations involve source objects and objective objects. For example to 
create a star cut-out on a square object, the star becomes the source object because it is used to cut 
the square. The square becomes the objective object because it is the one to be cut. 
 

Group 
This command Group one or more objects in the work area. The single objects keep their 
structure, but the transformation and movement operations involve all of the batched objects. 
Groups containing strings can be used to change the text without prior separation. 

 
Ungroup 
This is used to separate the objects combined with the batch function. The separated objects 
can then again be configured and transformed individually. 

 
Merge 
is used to obtain an object with a single outline. It is possible to independently weld the 
objects even if they are overlaid. If objects are welded which are not overlaid, it is possible to 
form a welding group which acts as a single object. In both cases, the welded object 
assumes the filling and outline attributes of the objective object.  
 

When single objects are welded with intersecting lines, the object is divided onto various sub-formats, 
while the aspect remains the same. 
The cut-out creates new irregular shapes by removing the areas overlaying other objects. The 
objective object maintains the filling and outline attributes. For example, if a text is cut overlaying a 
circle the text area is removed, thus creating the effect of a reverse text. 
 
Before cutting out the objects it is necessary to establish which object is going to be cut (objective 
object) and which objects to use in the cut-out. The objects used for the cut-out must be overlaying or 
be overlaid by the objective object. 
The intersection creates a new object from an area where two or more objects overlay. The shape of 
this new object can be simple or complex, depending on the intersected shapes. The filling and outline 
attributes of the new object are based on the object set as the objective object. 
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The grouped objects are listed in the related properties window. For objects created in Smartist (text, 
barcodes, data matrix etc.) it is possible to edit their contents from the properties window. 
 

 
 
The intersect command can also be applied to single imported objects, as long as they have complex 
filling surfaces. 

Applied separation function for imported vectorial objects 
 
In the imported vectorial objects the operator can set import filter quality parameters (see the chapter 
“Vectorial import filters”).  
“Image 1” shows a vectorial logo imported with a low quality parameter. In this case, the object is 
monolithic, the filling, resizing etc. functions will be uniformly applied to the entire logo. 
“Image 2” shows the same logo but with a high quality parameter. In this case the logo can be 
separated, and it is possible to apply modifications to the single units the logo is composed of.  
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Moving/re-dimensioning objects 
 
It is possible to position the objects by dragging them to a new location, using a shift operation, or by 
specifying the horizontal and vertical position. 
The set values 
To specify the position of an object, the horizontal and vertical coordinates to a central anchorage 
point of the object can be indicated or to another anchorage point. A small "x" marks the anchorage 
point. 
By default, the point of origin (0,0) corresponds to the central point of the work area. 
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Alignment of objects 
Smartist 4 can be used to align and distribute objects in the drawing. Alignment can be used to 
precisely align any series of objects. For example, it is possible, to align a series of objects horizontally 
or vertically. 
 
  Alignment of selected objects to the left 
 
  Alignment of selected objects to the right 
 
  Alignment of selected objects at the top 
 
  Alignment of selected objects at the bottom 
 
  Alignment of selected objects along the y axis 
 
  Alignment of selected objects along the x axis 
 
 

Reference object 
 
Alignment operations for objects are characterized by a reference object. The reference object is the 
central point of the alignment and the selected objects move as a consequence.  
The reference object can be identified by the black square apices. In the example below the reference 
object is the upper string. To change the reference object push the Control (CTRL) key and select a 
new on in the work area.  
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Rotating and Mirroring Objects 
Smartist 4 can be used to rotate the objects and create mirror images. It is possible to rotate an object 
by specifying the angle "Angle" on the "General" page of the object properties.  
It is also possible to change the rotation center "Position" in the same way, this is identified with a 
small "x"  from the related menu in the property window. 
 

 
 
Mirroring of the object is done by selecting  Actions > Mirror > horizontal (or vertical), or by using the 
keys on the tool bar. 
 
  Mirror object along vertical axis 
 
  Mirror objects along horizontal axis 
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Shearing and lengthening objects 
In Smartist 4 it is possible to shear and lengthen objects. To shear an object it is necessary to specify 
the value in degrees of required shear by specifying on the "general" page of the object properties the 
shear for axis X (shear X) and axis Y (shear Y). The same result can be obtained by dragging the 
relative apices after selecting the object. 
 

 
The example in the figure shows shearing along axis X obtained by dragging the lower central apex. 
 
To lengthen an object it is necessary to change the dimension value (Height and Width) on the 
"general" page of the object properties. The same result can be obtained by dragging the relative 
apices after selecting the object. 

 
The example in the figure shows lengthening along axis X obtained by dragging the lower right apex. 
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Using the grid 
The grid is a series of traced lines which intersect. They can be used to precisely align and position 
objects in the drawing window. 
 
The distance between lines in the grid can be set by specifying the spacing in the document property 
window: 
 
General > Snap to grid > Size 
 
The "Size" spacing refers to the exact distance between each line, lower spacing values can be used 
to align and position objects with greater precision. 
 
To display the grid in the drawing window the following tag needs to be enabled: 
 
General > Snap to grid > Grid 
 
To snap to grid objects the following tag needs to be enabled: 
 
General > Snap to grid  
 
Snap to is used to move objects and align them to the closest grid line. 
 

 
 
 
NOTE: 
to display the document property window deselect each object in the drawing area. 
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Project structure 
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Project Structure 
The project is a container which houses single graphic works and related functions. 
The following items may be located inside the project: 
 
Plain 
 
This is a graphic work for plain engraving. By selecting Project > Add plain (or using the related icon) a 
work for plain engraving is added to the project, defined by the word PLAIN. Select the related pain to 
access the graphic area where it is possible to draw or import objects for plain engraving. 
 
Ring 
 
This is a graphic work for ring engraving. By selecting Project > Add ring (or using the related icon), a 
work for ring engraving is added to the project, defined by the word RING. Select the related pain to 
access the graphic are where it is possible to draw or import. objects for engraving on the separator. 
 
Clone  
 
This is a copy of a previously set Plain or Ring. The Clone function is related to the identification 
number of the original graphic work. Therefore the Plain or Ring to be cloned must have an ID 
number. 
 
Wait Start 
 
This command interrupts execution of the project. Engraving is stopped at the end of the Plain or Ring 
prior to the Start wait. This period ends with a Start Engraving signal. 
 
Get and Go 
 
This command is used to jump inside a project sequence. The conditions for effecting this function 
come from a reading of the signals on the Input ports. If the set condition occurs, the project will 
resume from the Plain or Ring defined by the corresponding ID. It is also possible to effect an 
unconditioned jump in the sequence. 
 
Set Out 
 
This command is used to Set or Reset the output bits on the interface board. 
 
Move axis 
 
This command is used to move the three mechanical axes (X, Y, Z) to the required position. 
 
Events 
The event element can be positioned inside the project sequence. The event is used to enhance 
customisation via VBScript. Precise functions within the project script can be associated to event 
identification. 
 
Delete 
 
Deletes the selected element. 
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The project is identified and represented by a series of works and correlated functions. When 
engraving starts, each project item is processed in the sequence set by the structure. 
The figure below shoes the structure of a hypothetical project. The various engraving jobs and related 
functions are carried out from top to bottom. 
 
The item order can be modified using the arrows on the toolbar. 
 
 

 
 
The pages shown on the lower part are used to access single graphic works to make additions or edit. 
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Project properties 
When a new project is created some general parameters need to be specified. These parameters are 
located in the property window and are displayed by selecting the project that has just been created. 
 
 

 
The following parameters are set from the General Page: 
 
Resolution 
Linear  Represents the approximation order for linear quotes. Every measurement unit that is  

entered will be approximated to the value set in this box 
Angle Represents the approximation order for angle quotes. Every measurement unit that is  

entered will be approximated to the value set in this box 
Relative Represents the approximation order for relative, thus expressed in percentages.. Every 

percentage value that is entered will be approximated to the value set in this box 
 
Measurement unit 
Linear Sets the measurement unit used in the project 
 
Project Customization 
Enables the use of VB script in the current project (see the related chapter) 
 
The following parameters are set on the Project Page: 
 
Project 
Text The name of the project can be set in this box 
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 Plain 
This is a graphic work for plain engraving. By selecting Project > Add plain (or using the related icon) a 
work for plain engraving is added to the project, defined by the word PLAIN. Select the related pain to 
access the graphic area where it is possible to draw or import objects for plain engraving. 
 
 
 

 
 
The following parameters are set on the Project Page: 
 
 
Document 
 
Text The name of a plain engraving work can be set in this box 
ID Sets an identification for a plain engraving work. Setting an ID is  

indispensable for enabling the Clone, Get and Go functions 
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Ring 
 

 
 
This is a graphic work for ring engraving. By selecting Project > Add ring (or using the related icon), a 
work for ring engraving is added to the project, defined by the word RING. Select the related pain to 
access the graphic are where it is possible to draw or import. objects for engraving on the separator. 
 
 
 
The following parameters are set on the Project Page: 
 
 
Document 
 
Text The name of a ring engraving work can be set in this box 
ID Sets an identification for a ring engraving work. Setting an ID is  

indispensable for enabling the Clone, Get and Go functions 
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I/O Management 
 
Some of the functions introduced to Smartist 4 can be used to pilot I/O signals located on the Laser 
control board. This possibility is particularly useful if the laser system is installed in complex systems 
or long assembly lines. In these cases the control board can manage inputs and outputs in order to 
optimize system integration. 
 

Laser control board 
The electronics which control the laser system and the related I/O signals is composed of a board with 
DSP controller (laser controller) which is inserted in a PCI slot of a standard PC. Up to four expansion 
boards can be connected to this board to control I/O signals. The following figure represents a 
connection. Module 0 is always present, in addition to the I/O/ signals set by the application, it also 
controls the mechanical axes; the subsequent modules are optional and control the I/O signals set by 
the application. 
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Control board I/O signals 
I/O signals are located on the control board expansion boards. The connectors are described below. It 
is possible to increase the number of expansion boards and thus increase the number of available I/O. 
 
NOTE: 
The connectors 1 and 2 mounted on the Laser controller are reserved for the scanner head (connector 
1) and for laser source signals (connector 2) 

I/O signals available on module 0 
DB 25 pin male - Axis motor connection. The DSP board is able to generate the signals used to 
operate the three independent axes driven by step motors. All signals are of the open-collector type, 
i.e. are active in conduction (GND output) and not active with high impedance. All inputs are opto-
isolated and require a voltage from 10 to 30 V to be activated. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
NOTE: 
Some signals are reserved for axis control. For additional information see the DSP board manual. For 
this reason, some I/O addresses set on port 0 (module 0) will not be accepted by the program. 
 
DB 15 pin male – Laser controls/status. The output signals of this connector are of the open-collector 
type, being active when conducting (output to GND) and not active when cut-off (high impedance). All 
inputs are opto-isolated and require a voltage from 10 to 30 V to be activated. 
 
Pin out 
1:  Out – Laser End. Active at end of engraving. 
2: Out – Laser Busy. Active during engraving. 
3: Out – Laser Ready. Active when system is ready. 
4: In – External Start. Starts engraving when activated. 
5: In – External Stop. Stops engraving in progress when activated. 
6: Input 13 
7: Input 15. 
8: Output 15 
9: 12V. 
10: DSP Ready 
11: N.C. 
12: GND 
13: Input 12 
14: Input 14 
15: Output 14 

Pin out 
1:  +12V  500mA 
2: Step Y. 
3: Step Z. 
4: Break X. 
5: Break Y. 
6: Break Z. 
7: Zero X. 
8: Zero Y. 
9: Zero Z. 
10: Disable X. 
11: Disable Y. 
12: Disable Z. 
13: GND. 

 
14:  N.U. 
15: Step X. 
16: Dir Z. 
17: Dir Y. 
18: Dir X. 
19: Input8. 
20: Input4. 
21: Input2. 
22: Input1. 
23: Output9 
24: N.U. 
25: GND. 
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Available I/O signals on Module 1 - 2 - 3 
DB 25 pin male. Manages I/O signals set by the application. The signals are of the open-collector type 
for outputs, i.e. are active in conduction (GND output) and not active when cut-off (high impedance). 
The inputs are opto-isolated and require a voltage from 10 to 30V to be activated. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
DB 15  pin male. - Manages I/O signals set by the application. The signals are of the open-collector 
type for outputs, i.e. are active in conduction (GND output) and not active when cut-off (high 
impedance). The inputs are opto-isolated and require a voltage from 10 to 30V to be activated. 
 
Pin out 
1:  Output 10 
2: Output 11 
3: Output 13 
4: Input 10 
5: Input 11 
6: Input 13 
7: Input 15. 
8: Output 15 
9: 12V. 
10: Output 12 
11: N.C. 
12: GND 
13: Input 12 
14: Input 14 
15: Output 14 
 
 

Pin out 
1:  +12V  500mA 
2: Output 0 
3: Output 2 
4: Output 4 
5: Output 6 
6: Output 8 
7: Input 0 
8: Input 1 
9: Input 2 
10: Input 3 
11: Input 4 
12: Input 5 
13: GND. 

Pin out 
14:  N.U. 
15: Output 1 
16: Output 3 
17: Output 5 
18: Output 7 
19: Input 9. 
20: Input 8. 
21: Input 7. 
22: Input 6. 
23: Output 9 
24: N.U. 
25: GND. 
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Wait Start 
 
The command interrupts execution of the project. Engraving stops at the end of the Plain or Ring prior 
to the Start Delay. The project resumes with a Start Engraving signal. 
 

Get and Go 
 
This command is used to jump within the project sequence. The conditions for running this function 
are via reading of the signals on the Input ports and DSP2 board and I/O modules connected to it. If 
the set condition occurs, the program runs restarting from the Plane or Rotor set by the corresponding 
ID. 
 
The condition is set when the conditions set on the input bits subject to test occur. 
 
The parameters which set the Receive and Send condition are: 
 
Enable  Enables the test on the input bits 
Bit n° Each displayed bit corresponds to the related input on the board, a condition is 

associated to the bit. 
Condition Don’t care The input is not tested 

If Reset The condition is true if the input is low 
   If Set  The condition is true if the input is high 
 

 
 
 
 
 
 



 

Laservall S.p.A. 77 Chapter 6 

 

Set Out 
 
This command is used to Set or Reset the output bits on the interface board. 
The parameters which set the Configure Out condition are: 
 
Enable  Enables the outputs on available ports 
Bit n°  
Each displayed bit corresponds to the related output on the board, a condition is associated to the bit. 
Condition  
Reset  The output signal is low 
Set  The output signal is high 
 

 
 

Move Axis  
 
This command is used to move the three mechanical axes (X, Y, Z) to the required position. 
The parameters which set the Axis Shift condition are: 
 

 
Enable Axis Enables the corresponding mechanical axis (set based on the Installed Hardware) 
Position  Coordinates positioning of the relative axis 
 



 

Chapter 6 78 Laservall S.p.A. 

DSP 2 Board diagnostic tool  
 
In Smartist 4 is available a diagnostic program able to test all the DSP 2 main functions.  
To enter the diagnostic program proceed as follow: 
 
Start > Programs > Smartist4 > DSP Diagnostic 
 
The following window will appear with the result of the inner diagnostic. 
 

 
 
The result can assume the following value 
 
Passed:  test correctly executed 
 
Failed:  Test failed 
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Driver inizialization 
It perform a diagnostic routine on the DSP driver 
 
Driver Comunication 
Receive a get info with the DSP parameters 
 
Board Comunication 
When failed, there’s a cumminication problem between DSP driver and DSP board 
 
Firmware load 
It test the correct firmware’s loading on the board by the driver 
 
Execution Time out 
Time out occourred during the test routine execution. 
 
Irq test start 
This test consist in a sequence of 10 interrupt request from the system 
 
Irq count match 
Verify the number of interrupt executed (=10) 
 
Reset state test 
Notify the reset status to DSP microprocessor 
 
Internal register test 
Verify the DSP register with write/read command 
 
Do-loop test 
Execute four hardware loops 
 
Memory integrity test 
Execute write/read cycle in order to test the memory integrity 
 
Timers test 
Verify the correct functioning of the five internal timers 
 
I/O modules 
Reply with the numbers of I/O modules installed. When the reply is zero, the test fail, verify the correct 
I/O module hardware installation. 
 
I/O 5V power 
Verify the 5V presence on DSP board. 
 
I/O 12V power 
Verify the 12V presence on DSP board. 
 
Sports loop-back 
Verify the correct functioning of the serial communication devices on DSP processor with RX/TX 
commands 
 
Head communication 
Verify the data exchange between the DSP processor and the galvo head. If the test fail, verify the 
hardware conection between DSP 2 boards – DAC converter – Galvo head 
 
 



 

Chapter 6 80 Laservall S.p.A. 

 

LDX Files 
Files generated in LDX mode are set as "connected" objects. They are generated by Smartist 4 and 
can be imported in a graphic area or project. 
The special feature of LDX files allows them to be imported in a project and dynamically updated. 
When an LDX file is edited, its picture imported in the project is also edited. This possibility is very 
useful when graphic files need to be updated remotely, or at work stations which are not necessary 
those of the engraving laser. 
 

Creating LDX files 
To create a LDX "connected" file apply the normal procedures for creating engraving projects 
described in the previous chapters. Creation of the graphic part is completely the same as that 
preciously described, to generate the LDX format the processed item needs to be saved using the 
command 
File > Save Document. 
Smartist 4 will propose saving the document with LDX extension. 
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Importing an LDX file 
 
An LDX file needs to be imported in an existing project. To import and LDX file and thus generate a 
connection, select the command Actions > Add > Import File, select the Type of LDX file and confirm. 
The "Linked" page will appear in the property window. 
 

 
 
 
The Id of the imported object will appear on the "Data" page, and the following will appear on the 
"Linked" page 
 
Enable  Enables a link with the LDX origin file, used to set the dynamic object 
Linked to  Sets the path and position of the original LDX file 
Reload  Press this button to update the link, any modifications made to the original LDX file  

will be replicated in the imported object 
 
 

NOTE: 
If the LDX object is not enabled (using the relative tag), the object itself will be treated as a normal 
imported file. 

 
 

NOTE: 
In the previous version 4.0, linked objects had an LDC extension. Smartist 4.1 can also manage LDC 
files, but subsequent modification will convert them to LDX. 
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Creation of a project template 
 
By saving a project in the folder /Smartist4.1/Templates and giving it the name default.prj, it will 
become the model of all new projects created in Smartist 4.1. 
 

 
 
This object is especially useful when you repeatedly need to create complex projects with several 
planes and highly customised ones. 
 
 
 
 

 



 
 
 
 
 
 
 
 
 
 

 
Chapter 7 

 
Laser 
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Axis commands 
Smartist 4 is able to manage up to three linear axes driven by a step motor. 
 

 Axis Z 
The program can be used for the integrated management of the Z axis (mechanical axis) for focusing 
on different levels. Either select Laser > Z axe or click "Z axe" on the toolbar to access the control 
window. 
  

 
Axis Z 
 
Zero flag  Detects the position of the mechanical axis (the Z axe is on the sensor) 
Zero search Enables a zero search along the Z axis, the zero position is related to a proximity  
Minimum height Sets the minimum height axis Z can reach 
Maximum height Sets the maximum height axis Z can reach  
Current position Indicates the current position reached by axis Z, may be an operator entered quote 
 
Laser Test 
These parameters are usually used during the focusing phase before engraving. See the related 
chapter for more information. 

 
The axis control window is used to display the current position by means of a numeric indicator 
showing the current position in millimeters and a colored bar which graphically represents the axis 
position total offset. The axis can be positioned from the window by entering the new position in the 
specific box or by means of the "Up" and "Down" scroll buttons on the keyboard. In the latter case, 
press the button to start the movement and hold it pressed. The movement will be automatically 
stopped when the button is released.  
The axis control function can also be used to reset, i.e. to automatically seek the mechanical reference 
position. Select "Reset". The axis will start searching. The search operation will stop when the 
mechanical zero sensor is reached. 
 
NOTE: 
Press the ESC key on the keyboard to stop any action (movement or reset). 

Graphic 
position 
indicator 

Dialogue 
window 

Numeric 
position 
indicator 
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Axis XY 
The program allows integrated management of the linear XY axes. These are mechanical axes used 
to position objects under the laser via step motor control. The axis control window can be accessed by 
selecting  “Laser”  “Axis XY” from the menu or by pressing the "Axis XY" button on the toolbar. 
 

 
Axis X 
 
Zero flag    Detects the position of the mechanical axis (the axe is on the  

sensor) 
Minimum height axis X  Sets the minimum height axis X can reach 
Maximum height axis X  Sets the maximum height axis X can reach  
Current position axis X  Indicates the current position reached by axis X, may be an operator 

entered quote 
 
Axis Y 
 
Zero flag    Detects the position of the mechanical axis 
Minimum height axis Y  Sets the minimum height axis Y can reach 
Maximum height axis Y  Sets the maximum height axis Y can reach  
Current position axis Y  Indicates the current position reached by axis Y, may be an operator 

entered quote 
 
Common 
 
Search for zero Enables a search for zero along axis X and Y, the zero position is related to a 

proximity fixed on both axes. 
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Ring Work Commands 
The program allows integrated management of the ring separator, indispensable for ring work 
engraving. The ring work control window is accessed by selecting “Laser”  “Ring work commands” 
from the menu or by pressing "ring work commands" button on the toolbar. 
 

  
Axis R 
 
Zero Flag Detects the position of the mechanical axis (the rotor is on the sensor) 
Zero search Enables a zero search along ring R, the zero position is related to a proximity 
Position axis R Represents the indicator of the current position reached by axis R, it is expressed in 

degrees and can be entered by the operator 
 
The ring control window is used to display the current position by means of a numeric indicator which 
displays the current position, and via a circular dial which graphically represents the position of the 
axis in relation to the total stroke. The ring can be positioned from this window by entering the new 
position in degrees. 
The ring control function can be used to reset, i.e. to automatically seek the mechanical reference 
position. Select "Reset". The axis will start searching. The search operation will stop when the 
mechanical zero sensor is reached. 
 
NOTE: 
Press the "ESC" button on the keyboard to stop any action (movement or reset). 
 
 
 
 

Graphic 
position 
indicator 

Numeric 
position 
indicator 
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Limits 
The term limits refers to displaying the margins of the drawing on the work plain. Margins are 
displayed using a red laser pointer (650 mm). 

Limits in the plain engraved area 
 
Either select "Laser" "Show selection limits" or click on the "Selection limits" button on the toolbar to 
display the engraving limits. In this way, you can see the pointer limits of the currently selected 
objects. 
Either select “Laser” “limits” or click on the "Limits" button on the toolbar to display the graphic object 
limits for the graphic area. In this way, you can see the pointer limits of the currently selected objects. 
 
During limit display the area involved in engraving is shown and NOT the profile of the object to be 
engraved. The limits always describe an orthogonal area. 
 
The example below shows how the limits for a sheared word (laservall) would appear. 
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Setting limit parameters 
The laser pointing parameters that are used to display engraving limits are listed in the "limits" window 
in Laser Control. To access the Laser Control window double click on the yellow triangular icon in the 
Tray Area. 
 

 
 
The parameters that can be configured are: 
 
Scanner 
Speed: Speed of pointing limits expressed in Kpoints/s 
 
Correction 
OffsetX: Alignment offset expressed in points on axis X 
OffsetY: Alignment offset expressed in points on axis Y 
ScaleX: Scaling of limits in relation to engraving expressed in % on axis X 
ScaleY: Scaling of limits in relation to engraving expressed in % on axis Y 
 
NOTE: 
This page is used to correct pointer limits in relation to engraving. In this way perfect overlaying is 
achieved even if the power laser and pointer laser wavelengths are different. 
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       Project test 
Smartist 4.1 can be used to simulate the engraving results.  
By installing Smartist 4.1 on a PC without DSP board and its related driver, it is possible to test the 
project via a video graphic simulator. 
In this way, by pressing the icon represented by a traffic light with a yellow light, which normally starts 
laser engraving, you access a new window where engraving is simulated. The simulation maintains all 
the speed, filling, wobble etc. parameters set in the document. 
 
 

 
 
 
 
NOTE: 
Simulation is automatically enabled if the DSP board and relative driver are not installed correctly. 
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Setting laser engraving parameters 
The engraving parameters must be set before engraving the generated file. Correct engraving 
parameters are essential to ensure engraving quality. The parameters depend on the laser source 
used by the material and the required process. Engraving parameters can be the same for all the 
graphic objects. It is important to notice that the document itself is also an object, its properties can be 
accessed when no other object is selected. Each graphic object uses the laser parameters properties 
of the document by default. You can set different laser parameters for each object. In this case the 
parameters will appear blue. 
 

 Document laser parameters 
To configure identical laser parameters for all objects in a 
document, simply click any point of the work area so that no object 
is selected. The engraving properties for the entire document will 
appear on the Laser page. 
 
Select "document property, "laser" to set the engraving parameters 
for all the objects in the work area. The following parameters can 
be set: 
• Passages 

This indicates the possibility of configuring more runs (up to 3) 
with differentiated laser parameters 

• Power 
This indicates the laser output power. The value is a percentage 
according to the maximum power of the laser used. 

• Shot Frequency 
This parameter is used to adjust the laser output frequency by 
directly operating on the Q-switch. The Q-switch is an electro-
optical system which controls the opacity of a lens making it 
possible to change the laser beam frequency. A lower 
frequency will generate "spotted" engraving while a higher 
frequency will allow "line" engraving. Frequency is inversely 
proportional the laser beam power, i.e. if the frequency is too 
high, the power may not be sufficient for the engraving process. 
The Q-switch may be compared to a sluice shutter which closes 
and deflects the laser beam. 

• Scan Speed 
This indicates the engraving speed. The value is expressed in millimeters per second. 

 
NOTE: 
a slower speed implies engraving a deeper engraving. Set a very slow speed (50-100 mm/sec.) for 
special processes (burnishing or deep engraving). 
 
• Pix delay 

Duration of pixels for bitmap engraving 
 
• Passes 

This indicates the number of runs required by the laser for engraving the imported objects. 
Increasing the number of passes will increase depth of engraving, consequently affecting the cycle 
time. 
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Engraving using different runs and laser parameters 
 
Various passages can be made, also with different engraving 
parameters.  
Select the combo box in the passages box in the window in the 
figure to an enable an engraving sequence with parameters which 
can be completely different. This option may be particularly useful to 
make several light engraving runs to clean the workpiece after a 
more incisive engraving process. 
 
 
In this example, the first engraving process was very incisive (three 
runs at 100% power). 
Sessions 2 and 3, on the other hand, are lighter for trimming and 
cleaning the engraving. 
 
NOTE: 
These data are only examples. The values are not significant for real 
engraving tests. Select the best parameters according to the material 
used and the required processing type. 
 
 
WARNING: 
To carry out a good cleaning run, it is important that the speed is the 
same as an engraving run. 
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Object laser parameters 
The parameters set for the object can be different from those set for the entire document.  
Select the object and the Laser page to set the required parameters. 
 
 
 

 
 
 
The edited object will appear blue. 
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Engraving on different materials 
 
Laser Smartist 4 can be used to save different laser parameters in a Materials library. When engraving 
on different materials, the parameters can be saved by entering the material name in the box where 
the word Materials appears and pressing the Save button to save the parameters in the list. 
 

          
 
The Find  function is used to find saved materials, that have identical parameters to the ones being 
used. 
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Wobble 
Wobble is a new function integrated in the Smartist 4 engraving software. The purpose of this 
application is to engrave the single lines of vectorial graphics, either True Type characters or imported 
figures, with thicker lines. The line thickness if normally equal to the dimension of the laser spot. 
However, for some applications this thickness may not be sufficient, the wobble function solves this 
problem. 
The figure below represents the functioning principle of the wobble. Figure 1 shows the result of a 
vector engraving with the wobble disabled. Figure 2 shows the same vector but with the wobble 
enabled. The conversion of the vector into a dense spiral provides greater thickness of the engraved 
line. The same function can be applied to any vectorial graphic that is going to undergo plain or ring 
engraving. 
 

 
 
Wobble function configuration parameters are: 
 
Ø Diameter: Represents the diameter of the spiral curve 
Speed:  Represents the frequency of spiral repetition 
 
NOTE: 
The wobble function configuration parameters must be tested and checked in order to obtain the 
desired effect. Engraving times with the Wobble function are longer, only use the Wobble function 
when absolutely necessary. 
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 In the project simulation it is possible to verify the result of the Wobble function. As seen in the figure 
below, the single line character has a much thicker outline. The same result would be obtained with 
real engraving. 
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Work mode 
 
Either press the button depicting a green signal or select the command Mode > Work Mode to access 
the "work mode". This mode is for working only, graphic editing operations and any editing of the 
engraving project is disabled, i.e. the loaded model cannot be edited in any way. In this operating 
mode, the program automatically updates the "active" components (such as the date or the counter) at 
the end of each engraving job. 
 
This mode is particularly useful in work environments where the operator assigned to engraving is not 
authorized to edit the engraving project. 
 
To exit the work mode, press the green signal again or select the Mode > Edit Mode command.  
 
Exiting from the work mode may be subject to a password. 
 

Password 
To prevent unauthorized individuals from accessing engraving project editing, it is possible to set a 
password to the edit mode, so that the operator can continue to engrave but all project editing is 
disabled. 
 
To set a password select the Mode > Set Password command. 
In the following dialogue box set the password and confirm. 
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Engraving with Smartist 4 
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Focusing 
Engraving in the conditions illustrated in the previous chapters implies that the laser head (see Lens) 
is at the correct focus distance from the item to be engraved. 
The Z axis control window can be used to carry out "engraving tests" for focusing. The program sends 
a test to the laser which will continuously engrave a geometric shape with predefined parameters and 
position the axis at the same time. A greater interaction of the laser with the material under 
examination indicates that the optimal focus has been obtained. 
 
NOTE: 
The correct position can be identified as the engraving point in which the laser generated noise and 
luminosity are at the maximum. 
 
To start the test, select the required geometrical shape (line, square or circle), set the dimensions in 
mm, set the laser parameters and enable the “Start Test” tag.  
 
 
 

      Carrying out the engraving 
To start engraving of the generated graphic file press the relative icon (yellow signal) or select the 
Laser > Start command. 
 
The process can be stopped at any time during engraving by selecting “Laser” > “Stop” on the menu 
or by pressing the "Stop" button (red signal) on the toolbar. 
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Setting waits 
As previously illustrated, the engraving process is achieved by means of a laser beam deflection 
device controlled by two retroactive electrical drives (PID) which angular position is proportional to the 
control voltage provided. Due to the very nature of the system, the reaction time (phase) of the drives 
is not negligible. Consequently, the system generating the control signals (usually a PC) will need to 
wait for the positioning operation in progress to end before starting the next process. 

 

Calculating waits 
The waiting times required for high quality engraving are illustrated below. Some waiting times are 
linear functions (linear phase) of the engraving speed and for this reason are parameterized by two 
variables, namely K: proportional coefficient for speed and C constant. The system computes the 
waiting time according to these two parameters with the following formula: 
 

speed
speedKCT

max
⋅+=  

 
The speeds indicated in the formula are expressed in thousands of coordinates per second and the 
maximum reference speed mentioned in the formula is equal to 1000 [Kcoord/s], which corresponds to 
the following speeds expressed in [mm/s] according to the lens: 
• f100 = 1133.3 mm/s 
• f160 = 1822.2 mm/s 
• f254 = 2900.2 mm/s 
 
The following example shows how to engrave the word "LASER": 
 
 
 
 
 
 
 
 
these examples will better illustrate how incorrect technical waiting time setting effect the result. 
 

Tfirst 
Waiting time for the scanner to actually reach the required position before switching the laser on.  
 
 
 
 
 
 
 
 

If the delay is lower than the optimal value, notice how 
the first vector of each polygon is distorted and longer 
than the correct length.. 
 
If the delay is higher than the optimal value, the 
engraving process will be slower but no effects will be 
visible. 
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Tnext  
Waiting time for the scanner to reach the correct position before tracing the vector after the first with 
the exception of the last. This waiting time is according to the engraving speed and depends on the 
angle between the two consecutive vectors. If the angle is equal to 180°, the waiting time will be equal 
to zero, while the waiting time will increase as the angle decreases, the time being maximum when the 
angle is equal to zero degrees. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tlast 
Waiting time for the scanner to reach the correct position before switching the laser off (scanning the 
last vector of a polygon). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tdraw (Diode Laser) 
Waiting time to allow actual laser emission before starting to scan the vector. 
 
 
 
 
 
 
 
 
 
 
 
 
 

If the delay is lower than the optimal value, notice how 
the last polygon vectors are shorter and incomplete.. 

If the delay is lower than the optimal value notice how 
the polygon vectors are rounded and not sharp 

If the delay is higher than the optimal value, notice how 
the vector end points are more marked. 

If the delay is higher than the optimal value, notice how 
the polygon vectors are more marked and deeper than 
they should be. 

If the delay is lower than the optimal value, notice how 
the first vector of each polygon is shorter. 

If the delay is higher than the optimal value, notice how 
the initial vector points are deeper. 
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Tjump (Diode Laser) 
Waiting time to allow the laser beam to actually go out before making a jump (scanning with laser off). 
 
 
 
 
 
 
 
 
 
 

Tramp / Ttresh (Diode Laser) 
Waiting time (Tramp) for allowing the laser beam to stabilize before actually starting to engrave without 
holding the laser in the same position., i.e. without engraving the material which may be exposed to 
the undesired radiation. This wait is only carried out if the laser is off for a time which is higher than the 
threshold time (Ttresh). 
 

Bitmap - Toff  
Waiting time for the scanners to reach a certain position before switching on the laser during bitmap 
picture engraving. 
 

Bitmap – Ton 
Waiting time for adjusting the depth of each pixel during bitmap engraving. Essentially, this is the 
minimum firing time for each pixel. 
 

If the delay is lower than the optimal value, notice the 
blurring between the polygons. 
 
If the delay is higher than the optimal value, the 
engraving process will be slower but no effects will be 
visible. 



 

Chapter 8 102 Laservall S.p.A. 
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VBScript 
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Information on VBScript 
VBScript is a scripting language derived from Visual Basic, it is used to add customized functions to 
Smartist 4. VBScript is a object-oriented programming language. In object-oriented scripting the 
information is organized into groups called classes. It is possible to create more than one item in a 
class, called objects, to be used in the scripts. It is possible to use classes pre-set by VBScript or 
create customized ones. 
When you create a class all the properties (characteristics) and all methods (behaviors) are set for 
each created object, just like setting objects in the real world. For example, a person is characterized 
by properties like sex, height, hair color and methods like how they talk, walk and throw. In this 
example, "person" is a class and each individual is an object or an item of the class. 
 
NOTE: 
The following paragraphs contain introductory information on the use of VBScript but it cannot be 
considered a complete guide. For further information, see the official programming manual.  
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Generating VBScript in Smartist 4 
 
To add VBScript to a project, the Project Customization tag must be enabled. An additional page 
labeled SCRIPT will appear to the side of the project pages. 
A pre-set script can be entered using the SCRIPT combo box located in the properties window or a 
new one can be written. 
The highlighting syntax us used to quickly display the basic elements that make up the script. 
Any errors  during execution of the script will be indicated by messages on the page. 
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Basic tools 
 

Variables 
 
VBScript is derived from Visual Basic, and the variables behave in almost the same way. 
The instruction Dim is used to state them. For example: 
Dim variable1 
Dim variable2 
etc. 
Or 
Dim variable1, variable2, etc. 
Those who are used to other languages know that when a variable is stated the type also needs to be 
set, i.e. if it contains a number, a string, a date etc. 
This distinction does not exist in VBScript: the variables do not have type. Management of a number 
or a string is entrusted to the VBScript interpreter. This makes it very easy to program, but you must 
be careful, as the following example shows: 
 
dim a,b,c 
a=inputbox("First Number:") 
b=inputbox("Second Number:") 
c=a+b 
MsgBox“Result “&c 
 
 
In the example, I assign the values to variables a and b via InputBox, i.e. the dialogue box which asks 
the user to enter a value. If I assign the value 3 the first time and the value 5 the second time, one 
would expect the line "MsgBox c" to print the value 8 and instead it displays 35. 
This is because a and b are interpreted as strings and the + sign instead of adding, chains the 2 
strings. 
To solve the problem the variables must be converted from string to numeric using Eval (..). 
 
Warning: types do not exist, but subtypes which characterize the variables do, they are: 
 
Boolean:  Can contain True or False.  
Byte :  Contains an integer between 0 and 255.  
Integer:  Contains an integer between -32,768 and 32,767.  
Currency: Value between -922,337,203,685,477.5808 and 922,337,203,685,477.5807.  
Long:  Contains an integer between -2,147,483,648 and 2,147,483,647.  
Single:  Contains a floating point number with single precision between – 

3.402823E38 and 3.402823E38 
Double:  Contains a floating point number with double precision between – 

1.79769313486232E308 and 1.79769313486232E308 
Date: Contains a number representing a date between 1 January 100 and 31 December 

9999. 
String:  Contains a string with a variable length composed of a maximum of around 2  

billion characters.  
Object:  Contains an object.  
 
The conversion of types is managed by VBScript when it is clear. In the previous example if 
subtraction was used the result would be correct: 
 
dim a,b,c 
a=inputbox("First Number:") 
b=inputbox("Second Number:") 
c=a-b 
MsgBox“Result “&c 
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In the first example there is the + sign which is used for adding and for chaining. Thus a and b are not 
converted into a numeric type, but are left in string type. To set this conversion the Cint function is 
used: 
 
 
dim a,b,c 
a=inputbox("First Number:") 
b=inputbox("Second Number:") 
c=Cint(a)+Cint(b) 
MsgBox“Result “&c 
 
 
 
The dim instruction is used to state a variable, but this statement is not mandatory: the program works 
even without the "dim a,b,c" line. This makes programming even faster because it is not necessary to 
state the variables, they only need to be set. 
When creating a complicated program it is advisable to use the "Option Explicit" command at the 
beginning of the program. 
This command requires stating the variables and is useful if you make a mistake in writing the name of 
a variable. If I make a mistake with the name, the variable does not exist and a error is generated. 
 
 
Option Explicit 
dim a,b,c 
a=inputbox("First Number:") 
b=inputbox("Second Number:") 
c=Cint(a)+Cint(b) 
MsgBox“Result “&c 
 
In choosing the name of a variable the following rules need to be taken into account: 
It needs to start with a letter of the alphabet. 
It cannot include periods and spaces. 
It must not be composed of more than 255 characters. 
There is no difference between upper and lower case letters. 
There is also a non-mandatory rule: to give a non-logic name to a variable and thus a variable that 
must contain a date of birth could be called dtDate_Of_Birth, where dt indicates that it is a date type. 
This is used to make programs easier to read. 

Operators 
VBScript operators can be divided into types: 
Arithmetic Operators 

  a=5 b=2 Result 
+ Add c=a+b 7 
- Subtract c=a-b 3 
* Multiply c=a*b 10 
/ Divide c=a/b 2,5 
\ Whole Division c=a\b 2 
Mod Module c=a Mod b 1 
^ Increase exponent c=a^b 25 
& String chaining c=a & b 52 

For complex formulas, addition and subtraction from left to right have precedence. 
Comparison operators 
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= Equal 
>= Greater than or equal to 
<= Less than or equal to 
<> Different 
< Less than 
> Greater than 

Comparison between two variables gives True or False 
Logical Operators 

Not Negation 
And Logical Conjunction 
Or Logical Disjunction 

These are used for operations with Boolean variables. They will be greatly used in the next chapter 
which examines conditional instructions. 
 
The following program is used to check arithmetic operators: 
 
 
Option Explicit 
dim a,b,c 
a=5 
b=2 
MsgBox "c=a + b ---->" & a + b 
MsgBox "c=a - b ---->" & a - b 
MsgBox "c=a * b ---->" & a * b 
MsgBox "c=a / b ---->" & a / b 
MsgBox "c=a \ b ---->" & a \ b 
MsgBox "c=a Mod b ---->" & a Mod b 
MsgBox "c=a ^ b ---->" & a ^b 
MsgBox "c=a & b ---->" & a & b 
 
 
In the previous chapter the operator + was used to combine two strings, here the & sign is used. The 
two operators are equivalent but it is advisable to always use the & sign to better distinguish an 
addition operation. 
 

Conditional Structures 
Let's try to some alternatives in the program. 
To carry out operations under certain conditions the main command is IF. The syntax is as follows: 
IF <condition> Then 
<operations if the condition is true>  
Else 
<operations if the condition is false> 
End If 
 
The following example uses the function Month(), which gives the month in a numeric form, and 
Now(), which gives the current date and time: 
 
if month(Now())=6 then 
MsgBox "It is June" 
end if 
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If the month is June, it will print "it is June". 
To make the program more complete: 
 
 
if month(Now())=6 then 
MsgBox“It is June" 
else 
MsgBox“It is not June" 
end if 
 
It is also possible to create structures inside other structures, i.e. nested structures: 
 
 
if month(Now())<=6 then 
MsgBox "We are in the first half of the year <br>"  
if month(Now())<=3 then 
MsgBox "it is the first quarter." 
else 
MsgBox "it is the second quarter."  
end if 
else 
MsgBox "We are in the second half of the year <br>"  
if month(Now())<=9 then 
MsgBox "it is the third quarter." 
else 
MsgBox "it is the fourth quarter."  
end if 
end if 
 
 
 
Notice the importance of an indent formatting when using structures that are this complex. 
Another use of the IF instruction is the give as many conditions as possible: 
 
 
 
if month(Now())<=3 then 
MsgBox "We are in the first quarter." 
elseif month(Now())<=6 then 
MsgBox "We are in the second quarter."  
elseif month(Now())<=9 then 
MsgBox "We are in the third quarter." 
else 
MsgBox "We are in the fourth quarter."  
end if 
 
You can see that in this type of structure only one operation is carried out. Starting from the top and 
moving towards the bottom, at the first condition the corresponding operations is effected and the 
structure is left. If it was January all the conditions would have been true but only the first sentence 
would have been printed. 
The logical operations NOT, AND and OR can be use to combine multiple conditions. When using 
structures with many choices based on the value of a parameter, you can use a structure with 
SELECT. 
This is the same program as above but with a SELECT structure: 
 
Select case month(Now()) 
case 1,2,3 
MsgBox "We are in the first quarter." 
case 4,5,6 
MsgBox "We are in the second quarter."  
case 7,8,9 
MsgBox "We are in the third quarter." 
case else 
MsgBox "We are in the fourth quarter."  
end select 
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In this structure the variable to check is set with the instruction "Select case Variable"., and then a list 
of possible values that the variable can assume with the instruction" case value1, value2, value3"; the 
operations to be carried out follow this instruction. In the example the variable is numeric, in the case 
of string variables the values are placed between quotation marks: case "value1", "value2", "value3". 
 

Structures for cycles 
A cycle is used to repeat operations for a certain number of times or until a certain condition occurs.  
The FOR - NEXT cycle increments by a variable at each cycle. When the variable reaches an 
established value the cycle finishes. 
 
Option Explicit 
Dim i 
For i=4 to 20 
MsgBox i & "<br>" 
next 
 
The program prints the values from 4 to 20 in a column. 
Using the STEP parameter, I can count backwards and use different steps. 
 
 
Option Explicit 
Dim i 
For i=20 to 4 step -2 
MsgBox i & "<br>" 
next  
 
 
This program will display the numbers 20, 18, 16, 14, 12, 10, 8, 6, 4 
The FOR - EACH cycle is similar. This cycle is based on a set  of objects and is repeated for each 
element of the set.  
In this example a vector is used. After being stated and filled, the following is displayed through a For 
Each cycle: 
 
Option Explicit 
Dim vector(5),element 
vector(0)="Html" 
vector(1)="Asp" 
vector(2)="Php" 
vector(3)="JavaScript" 
vector(4)="VBScript" 
for each vector element 
MsgBox element & "<br>" 
next 
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The DO LOOP cycle is repeated until a condition becomes false. The following code will be repeated 
until a second has passed from when it starts. The variable counted increments with each cycle. This 
is a way of appreciating your own computer! 
 
Option Explicit 
dim StartTime, EndTime, count 
count=0 
StartTime=now() 
EndTime=now()+1/(100000) 
do While now()<=EndTime 
count=count+1 
loop 
MsgBox "The cycle is repeated " & count & " times"  
MsgBox " in 1 second" 
 
 
If the condition never occurs, the cycle is not carried out even once. By moving the condition to the 
bottom, the test is carried out and then the condition is checked. In the following example the words 
"Test Until" are displayed even if the condition is false. 
 
 
Option Explicit 
dim a 
a=10 
do  
MsgBox "Test Until"  
loop While a < 0 
 
The cycles can also be nested. In the following code the contents of a matrix is displayed. 
 
Option Explicit 
dim cLines, Columns, Matrix(3,2) 
matrix (1,1)=1 
matrix (2,1)=2 
matrix (3,1)=3 
matrix (1,2)=4 
matrix (2,2)=5 
matrix (3,2)=6 
for cLines=1 to 3 
for cColumns=1 to 2 
MsgBox mstrix(cLines,cColumns) & " " 
next 
MsgBox "<br>" 
next 
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Objects 
Like in Visual Basic, in VBScript w also find the concept of object. An object is an entity which has 
properties, actions (methods) and generates events. 
An item needs to be created to use an object, i.e. it needs to be stated and associated to a name. 
To do this the CreateObject command is used. The syntax for creating an object is as follows: 
Set object name= CreateObject( "type of object") 
 
The objects (Active Objects) available in Smartist 4 are listed below:. 
 

Smartist 4 Active Objects 
 
Type: Global 
Name: Project 
 
Description: 
This object exports global function to modify the project 
  
Properties 
ActiveItem  Sets/Gets active item indices 
  
Methods 
ShowWindow  Displays the laser window if it is not visible 
 
LoadProject(path)  Loads a new project and gives a TRUE value if successful. 
 
ItemCount  Gives a number of project items 
 
SelectActiveItem(id) Activates the item set by the specified ID, gives the item index if successful, 

otherwise gives the value of -1 
ShowActiveItem Displays the page associated with the active item, gives TRUE if successful 
 
ProcessActiveItem  Processes the active item (sends the data to the laser and launches 

engraving). Gives TRUE if successful. 
 
GetActiveDocument  Gives the document associated with the active item. 
 
UpdateViews  Updates the views 
 
Events 
 
OnQueryStart  External start request (or software) 
 
OnItemStart  Start Item is launched 
 
OnItemStop  Start Item is stopped by the software or external stop. 
 
OnItemEnd  Start Item ended 
 
OnClose   Selects work mode for modify mode or closes the active project 
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Type: Global and Local 
Name: Document 
 
Description: This object is a global shortcut to the first project document where the script is being 

executed.  The Document object is particularly useful when it is necessary to 
customize a single document. It is possible to obtain a local document using the 
GetActiveDocument function for the project objects  

  
Properties None 
 
Methods 
 
Load(path) Loads a document from the disk giving true if successful. 
  
Save(path) Saves a document from the disk giving true if successful. 
 
Show  Shows a page associated with the document 
 
GetObject(id) Gives the document identified by the specified ID 
 
Events  None 
 
Type: Local 
Name: String 
 
Description: Strings are not global objects, but they can be obtained from the document using the 

GetObject function and specifying the ID of an existing string.  
. 

 
  
Properties 
 
Text  Sets/Gets the text object 
 
Compression Sets/Gets string compression 
 
Spacing  Sets/Gets sting spacing 
 
CharHeight Sets/Gets character height 
 
CharAngle Sets/Gets character angle 
 
CharShear Sets/Gets character shear 
 
Radius  Sets/Gets string radius on the circumference 
 
Angle  Sets/Gets start angle of the string on the circumference 
 
Methods 
 
Update  Updates the object while the modifications have effect 
 
Length  Gives the number if string characters 
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Events 
 
Type: Local 
Name: Barcode 
 
Description: Bar codes are not global objects but they can be obtained by the document  

using the GetObject function and specifying an ID of an existing Bar code. 
  
Properties 
 
Text  Sets/Gets the object text 
 
Methods 
 
Update  Updates the object while the modifications have effect 
 
Length  Give the number of bar code characters 
 
Events 
 
Type: Local 
Name: Datamatrix 
 
Description: Data matrix are not global objects but they can be obtained by the document  

using the GetObject function and specifying an ID of an existing data matrix.. 
  
Properties 
 
Text  Sets/Gets the object text  
 
Methods 
 
Update  Updates the object while the modifications have effect 
 
Length  Gives the number of data matrix characters 
 
Events 
 
Type: Global 
Name: Axis 
 
Description: The axis object id used to manage the mechanical axes 

To select axis X use index 0 
 To select axis Y use index 1 
 To select axis Z use index 2 

 
Properties 
 
Position(index) Sets/Gets the position of the selected mechanical axis 
 
Methods 
 
IsEnabled(index) Gives TRUE if the selected axis is active 
 
IsOnZero(index) Gives TRUE if the selected mechanical axis is in the Zero position 
 
Reset(index) Starts a search for zero on the selected mechanical axis. Gives TRUE if successful.  

 
Move(index,position) Moves the selected mechanical axis to the specified position, gives TRUE if 

the command is correctly carried out  
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Break(index) Stops the movement of the selected mechanical axis, gives TRUE if the command is 

correctly carried out 
   

Events 
 
OnReachZero(index) Zero position of the selected mechanical axis reached 
 
OnReachPosition(index) Requested position of the selected mechanical axis reached 
 
Type: Global 
Name: IoPort 
 
Description: The IoPort object is used to pilot output signals and read input signals  
Properties 
 
Methods 
 
PortsCount Gives the number of I/O modules and related available ports 
   Each port has 16 output bits and 16 input bits 
 
SetPort(port,mask) Configures the output of all bits via the selected port mask 

 
 
ResetPort(port,mask) Resets all output bits via the selected port mask 
 
GetPort(port)  Gets the input bit mask of the selected port 
 
CheckPort(port)  Checks the inputs of the selected port 
 
UncheckPort(port) Stops the input test of the selected port 
 
Events 
 
OnInputChange(port) Checks the change of at least one bit on the monitored port 
 
Type: Global 
Name: ComPort 
 
Description: The ComPort object is used to configure on of the serial ports installed on the 

system  
 
Properties 
 
Methods 
 
Open(parameters) Opens the port selected with specific  parameters. The parameters 

are represented by a string with the following syntaxes: 
  Port,speed,data bits, stop bits, Equality (i.e.: "COM1,9600,8,1,NONE"). 

    The function gives TRUE if successful 
 
 Close    Closes the port 
 
 Write(string)  Sends the character string to the port, gives TRUE if successful 
 
 Read   Reads the port. The function gives the received character string 
 
 SetFlag   Configures the flag character (end transmission character) 
 
 Flush   Resets the port flush 
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DTR   Configures/Resets DTR signal (data terminal ready), gives TRUE if   

successful  
 
RTS   Configures/Resets RTS signal (request to send), gives TRUE if   

successful 
 
Events 
 
OnTxComplete  Transmission complete 
 
OnRxChar  A character has been received 
 
OnRxFlag  Flag Received (end transmission character received). 
 
OnError   Error on line 
 
OnBreak   Input interruption 
 
OnRing   Ring indicator 
 
OnRSLD   RSLD signal (receive line signal detect) has changed logic state 
 
OnCTS   CTS signal (clear to send) has changed logic state 
 
OnDSR   DSR signal (data set ready) has changed logic state 
 



 

Laservall S.p.A. 117 Chapter 9 

 

Examples of VBScript 
 
Example 1 
The following VBScript randomly rotates the object in the engraving area 
 
 
Document.Show 
 
Sub Project_OnQueryStart 
 OfsX = Int(100 * Rnd - 50) 
 OfsY = Int(100 * Rnd - 50) 
 Ang  = Int(360 * Rnd) 
 
 Document.Move OfsX,OfsY 
 Document.Rotate Ang 
 Document.Show 
 
End Sub 
 
Sub Project_OnClose 
 'Document.Move 0,0 
 'Document.Rotate 0 
 'Document.Show 
End Sub 
 
 
 
Example 2 
This VBScript puts a pre-set string (“Smartist 4 Laservall) in the work area on a circumference with 
pre-set characteristics. 
 
Document.Show 
 
On Error Resume Next 
 
Set MyString = Document.CreateString(1) 
If Err.Number = 424 Then  
 MsgBox "Impossible to create string ID: 1" 
Else 
 MyString.Text = "Smartist 4 Laservall" 
 MyString.Radius = 30 
 MyString.Angle = 90 
 MyString.Update 
End If  
 
Project.UpdateViews 
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VBScript applied to the single object - Formatters 
It is possible to apply customised formatting to single objects (text, bar codes or 3D codes) using 
VBScript formatters. It is possible to assign formatting to an object by selecting the related formatters 
as shown in the following figure. 
 

 
 
The formatting scripts are saved in the folder ../smartist4.1/formatters/ . 

Example of formatters 
The following script simulates the division of working hours into three shifts, it queues a character to 
the selected string: A, B or C depending on the time of day the engraving takes place. 
 
' Get current time 
Hours = CInt(Hour(Now)) 
' Adds the character to the string with the following principle 
' from 6  to 14 --> A 
' from 14 to 22 --> B 
' from 22 to 6  --> C 
If Hours >= 6 And Hours < 14 Then 
  Text = Text & "A" 
ElseIf Hours >= 14 And Hours < 22 Then 
  Text = Text & "B" 
Else 
  Text = Text & "C" 
End If 
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Customizing Smartist 4 
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Origin of the work area 
 
The coordinates set in an engraving job, either plain or ring, have an origin as a reference. The origin 
is the point of coordinate 0.0 that the objects in the engraving area refer to. The point of origin is 
invisible but its position is indicated on the General page of the selected job. 
By default, Smartist 4 sets the center of the work area as the point of origin. 
 

Moving the origin of a work area 
 
To modify the origin position, open the combo box related to the origin position and set the new 
position. 
If you set the CUSTOM position, it is necessary to enter new X,Y coordinates which will set the new 
origin of the work area. 
 
 

 
 
NOTE: 
If a Custom origin is set, i.e. with coordinates set by the user, the grid will automatically be positioned 
in relation to the new origin. 
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Installing new fonts 
The engraving program uses specifically made fonts to optimize the number of vectors forming the 
various letters for engraving applications. In addition, the program can convert True Type fonts 
installed in the system into its own format. If you want to install a particular type of True Type font for 
engraving, close all the open models and select “File”  “Fonts…” to open the font installation 
window. 
 

 
 
You can select a standard font installed in the system, see a preview and add it to the laser font list by 
pressing the  “>>” button. Press the "X" button to delete a font. 
 
NOTE: 
The font menu can only be accessed if all engraving jobs are CLOSED 
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Setting the focus 
 
To set the type of focus currently used by the engraver select Laser Control. This window contains a 
list of available lenses, by selecting a lens its parameters are displayed. 
 
The width of the work are is set by the focus length set in Laser Control. 
 

 
 
 
• Open the Laser Control application by clicking twice on icon 1 in the Tray area 
• Select the Correction page 
• Open Combo Box 2 and set the focus used by the engraving laser 
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Mechanical Axis Management 
The engraver can manage three mechanical axes, namely X, Y and Z. The following figure shows how 
the axes are positioned (in black): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The program can define a minimum height (Min), a maximum height (Max) and a zero height (Zero) for 
each axis. Each axis can be reversed. 
 

Linear axes 
The Z axis in the figure has a zero height which is different from null and is reversed. The X and Y 
axes (mechanical) coincide with the x and y axes (logic).  
In this example, the logic height z + 0 mm coincides with the focus height from the working plain. A 
height z > 0 mm would mean that the focus position is over the working plain. 
 

Rotary axis 
Axis management is completely independent from the axis itself. This is because the engraving 
program can be configured to manage an angular axis simply by setting the Z axis to "zero" at the 
center of the ring and configuring the rotary axis conversion factor in order to correctly convert the 
angular positions (e.g. "steps per revolution"/ 360 = sexagesimal degrees). In the following example, 
axis x is a rotary axis. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mechanical zero 

Logic zero 

Working plain 

Z

Mechanical zero 

Logic zero 
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Connecting an axis (Step Controller) 
The DSP board is able to drive up to the independent step type axes. The board uses the following 
signals to control each axis: 
 

Step:  Open collector output, generates the steps for the step motor controller.  
The generated frequency is based on the set movement speed, the duty-cycle is 
equal to 50%. 

  Dir: Open collector output, direction signal. 
  Break Open collector output, brake unlock signal 
  Zero: Opto-isolated input, mechanical zero detection input. 
 
The following diagram shows how to connect an axis driven by a step controller to the DSP board. 
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DSP board management 
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Laser Control 
The "DSP" control program is used to set laser engraving parameters for the various applications. 
Each set of parameters is logically grouped on a page to facilitate access. The program can be 
accessed from the "Control Panel" via the "DSP Control" icon or from the yellow icon depicting laser 
emission present in the "Tray Area"(the area in the lower right on the Windows bar) of the Windows 
shell as shown in the figure below. 

 
 
Installation of the program takes place automatically when the Smartist 4 graphic editor is installed as 
described below. 
 

Click twice with the left side ot the 
mouse to start the laser setting 
program 
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“Scanner” parameters 
 

 
 
 
This page is used to set the scanner speed when the laser is off (Jump Speed) and the waiting times 
for adjusting the engraving quality with respect to running times. 
 
NOTE: 
See Setting Waits for the correct wait settings. 



 

Chapter 11 128 Laservall S.p.A. 

“Laser” parameters 
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The “Laser Parameter” page is used to set: 
 
• Source Type: 

the default laser source is diode pumped Nd:YAG. Lamp pumped Nd:YAG lasers or CO2 lasers 
can also be configured 
 

• Power Type 
LEVEL: Level modulation for Nd:YAG lasers  
DUTY: Duty modulation for CO2 lasers 
 

• Pen  Down: 
PRESET: see the following paragraph: “Configuration of the pen down PRESET signal” NORMAL 
see the following paragraph: “Configuration of the pen down NORMAL signal”  
 

• POWER CHANGE 
ONCE: Applied only on the first engraving pen down 
ALWAYS: Power change is applied to every power variation (level). Option used on lamp pumped 
Nd:YAG lasers 
 

• FPK Available:  
Enables First Pulse Kill 
 

• Min.Level% 
Minimum current level expressed in V. Corresponds to 0% of power. 

 
• Thermal Level 

Thermal level during the period of “power change” “Stand By” 
 

• Max Level% 
Maximum current level expressed in V. Corresponds to 100% of power. 
 

• Ramp Time: 
Time, expressed in ms, for effecting the ramp used to pass from the minimum level to maximum 
level. 
 

• Power change:  
Thermal standby, expressed in ms, it is the standby time between the end of the level ramp and 
start of engraving. This standby serves for the laser to stabilise before starting to work. 
 

• Stand by:  
Standby expressed in s, this is the standby time between the end of engraving and the level ramp 
which resets the minimum value (of standby). This standby lets the laser remain stable between 
two close engraving with consequent saving of work time. 
 

• Shot time:  
Duration of the laser shot pulse, expressed in us. 
 

• FPK – Level:  
Level of the first pulse killer, expressed in V. 
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Configuration of the pen down NORMAL signal 
The following figure shows the behaviour of the DSP board signals when engraving two squares. 
N.B.: 
The jump speed may seem lower than the engraving speed only for the purposes of graphic 
representation, normally the jump speed is higher than engraving speed. 
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Configuration of the pen down PRESET signal 
The following figure shows the behaviour of the DSP board signals when engraving two squares. 
N.B.: 
The jump speed may seem lower than the engraving speed only for the purposes of graphic 
representation, normally the jump speed is higher than engraving speed. 
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“Correction” parameters 
 

 
 
This page is used to set the optical correction required to recover the distortion of mirrors and lens. 
The parameters are: 
• X/Y:  

Value, expressed in degrees, indicating the curvature to be applied to each axis. 
• Scale X/Y:  

Scale, expressed in %, to be applied to each axis. 
• Reverse X/Y axe:  

To reverse the relative axis. 
• Swap X-Y axes:  

To swap X axis and Y axis 
The three axis reverse parameters are used to direct the engraving field in the four angular positions:: 
0°, 90°, 180° and 270° as described below: 
 0° rotation     : None. 
• 90° rotation   : Reverse X + Swap X-Y. 
• 180° rotation : Reverse X + Reverse Y. 
•  270° rotation : Reverse Y + Swap X-Y. 
 
NOTE: 
See Foundations on engraving and optical correction for a better understanding of optical 
correction. 
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“Limits” parameters 
 

 
 
This page is used to correct the pointer limits in relation to engraving. This allows perfect overlaying, 
even when the power laser and the pointer laser wavelengths are different. The following parameters 
can be set: 
 
• Speed:  

Pointer limit processing speed, expressed in Kspots/s. 
• OfsX/Y:  

Alignment offset, expressed in points per respective axis. 
• ScaleX/Y:  

Limit scaling in relation to engraving, expressed in % on the respective axes. 
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“Inputs"/"Outputs" parameters  
 

 
 
These two pages are used to set durations and delays of laser Input signals in relation to engraving. 
The parameters are: 
 
• Inputs – Start Time:  

Used to set the minimum duration of the start engraving signal expressed in ms. 
• Inputs – Start Delay:  

Used to set the delay, in ms, between acceptance of the start engraving signal and actual start of 
engraving. 

• Inputs – Stop Time:  
Used to set the minimum duration of the stop engraving signal, expressed in ms. 

 
• Outputs – Busy Advance:  

Advance, expressed in ms, of the Busy signal (engraving in progress) compared to the start of the 
work. This parameter may be useful if this signal is used to open an electromechanical shutter. 

• Outputs – Busy Delay:  
Delay, expressed in ms, of the Busy signal compared to the end of the work. 

• Outputs – End Delay:  
Duration of the end engraving signal. 

 
 



 

Laservall S.p.A. 135 Chapter 11 

“X/Y/Z Axe” parameters 
 

 
This page is used to set the parameters related to the three mechanical axes controlled by step 
motors. The parameters are: 
• Enable:   

To allow axis use. 
• Conversion:  

These two parameters establish the correspondence between motor steps and millimeters of shift. 
• Motor – Break release:  

Electromechanical brake release time, expressed in ms. This is the time which passes between 
brake release signal activation and mechanical movement start. 

• Motor – Ramp Time:  
This is the time, expressed in ms, employed by the acceleration ramp to go from minimum speed 
(Start speed) to working speed (Speed). 

• Motor – Start speed:  
Minimum motor revolution speed, expressed in mm/s. 

• Motor – Speed:  
Motor revolution speed at the end of acceleration, expressed in mm/s. 

• Limits – Min:  
Minimum motor position limit, expressed in mm. 

• Limits – Max:  
Maximum motor position limit, expressed in mm. 

• Limits – Zero:  
Position (in mm) of the axis logic zero in relation to the mechanical zero. Each movement of the 
axis is considered in relation to the logic zero. Conversely, axis resetting locates the mechanical 
zero. 

• Limits – Reverse Axe:  
To reverse axis logic. 

NOTE: 
See Mechanical Axis Management for additional information on axis use and parameter settings. 
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Engraving and optical correction 
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Foundations of engraving and optical correction 
The scanning head used for laser engraving employs two electrical drives to set the angular position 
of the two mirrors and deflect the beam along the two directions X and Y. A simplified diagram is 
shown below (Fig. 1): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Distortion 
The picture projected on the engraving surface by the two mirrors is deformed due to the different 
length of the optical paths for the different angles. Observe Fig. 2. The point on the plain does not 
follow a straight line parallel to the x axis as angle ϑx  varies, instead it follows a trajectory which is 
similar to a parabola distancing the hypothetical line according to the two angles ϑx and ϑy. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

L

G G

L

Figure 1: Scanning head 

Figure 2: Projection on plain 
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The coordinates of the projected point can be computed with the following formula: 
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The error - i.e. the discrepancy between the real y and the ideal value according to the variation of xϑ  
is: 
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as a result the angular correction to be applied to yϑ  to compensate this distortion is: 
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Barrel distortion 
The lenses used for scanner heads (e.g. RODENSTOCK f-theta objective), in addition to focusing on 
the work plain, apply a deformation ,called barrel distortion, to eliminate the dependency from the 
tangent. 

yhy ϑ⋅=  
 

The use of these lenses could simplify the task of the software by eliminating tangent distortions. 
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Laser Tune 
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LASER TUNE 
 
Laser Tune is an advanced tool that allow an high precision optical correction on the laser scanner 
head. It is used for adapting a correction file to the laser application program. The correction file 
created by Laser Tune includes all information necessary for scanning within a flat working area. 
Furthermore the field distortion caused by the two-mirror system is compensated. 
 

Install Laser Tune 
Laser Tune is automatically installed during the laser application program installation. An icon named 
Laser Tune will be added to relative menù. 
 

Use of Laser Tune 
The correction consist of two tables containing the correct output values for the x and y coordinate of 
certain points in the working plane. These points are 65 x 65 grid points of a square grid which is 
superimposed on the working plane. The distance between  neighbouring grid point is 1024 bit. The 
grid space in mm can be calculated by dividing 1024 bit by the calibration factor of the correction file in 
nits/mm, which can be found in the name of correction file  
 
To perform the scanner calibration proceed as follow: 
 
- Start the Laser Tune Application program 
- Set the engraving laser parameter  
- Select the correct objective 
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Calibration Accuracy level 
 
The accuracy level depends on the matrix size used. Four different calibrations levels are available: 9, 
25, 81, 289 points. Increasing the matrix size it increase the calibration accuracy level. 
 
The calibration is always performed from the lowest level (9) to the maximum one (chosen by the 
operator between 9, 25, 81, 289). 
 

 
 
Choose OK to proceed with the calibration. 
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Step 1 
Follow the message on the screen to engrave the first matrix made by 9 points. 
Take the engraved piece and start the measurements. Measure the X,Y coordinates of each matrix 
vertex highlighted in the grid on the screen and enter the new coordinates into the editboxes. 
Each coordinate refer to the origin placed in the middle of the grid. 
 

 
 
 

 
 
When all the 9 coordinates has been measured and their new values entered in the program, click on 
NEXT to proceed with the calibration step 2 
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Step 2 
Follow the message on the screen to engrave the first matrix made by 25 points. 
Take the engraved piece and start the measurements. Measure the X,Y coordinates of each matrix 
vertex highlighted in the grid on the screen and enter the new coordinates into the editboxes. 
Each coordinate refer to the origin placed in the middle of the grid. 
 

 
 

 
 
When all the 25 coordinates has been measured and their new values entered in the program, click on 
NEXT to proceed with the calibration step 3 
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Step 3 
Follow the message on the screen to engrave the first matrix made by 81 points. 
Take the engraved piece and start the measurements. Measure the X,Y coordinates of each matrix 
vertex highlighted in the grid on the screen and enter the new coordinates into the editboxes. 
Each coordinate refer to the origin placed in the middle of the grid. 
 

 
 

 
 
When all the 81 coordinates has been measured and their new values entered in the program, click on 
NEXT to proceed with the calibration step 4 
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Step 4 
Follow the message on the screen to engrave the first matrix made by 289 points. 
Take the engraved piece and start the measurements. Measure the X,Y coordinates of each matrix 
vertex highlighted in the grid on the screen and enter the new coordinates into the editboxes. 
Each coordinate refer to the origin placed in the middle of the grid. 
 

 
 
When all the 289 coordinates has been measured and their new values entered in the program, click 
on SAVE, to create the calibration file or REPEAT to verify or improve the calibration with a new 
measurements of the 289 new coordinates. 
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Laser Tune Files 
 
To save the file, choose the destination folder and click on SAVE. 
 

 
 
 

Laser Tune in Laser.ini 
 
When the CTB file is saved, it generates a second file in the application program BIN folder. This new 
file is named depending by the objective selected in the optical calibration procedure: 
 
Default file name: 
 
corr000.cor for 100mm focal length 
corr001.cor for 160mm focal length 
corr002.cor for 254mm focal length 
 
In case of calibration of a 160mm focal length, the Laser.INI file result as follow 
 
[Obj001] 
Description = f = 160mm (110 x 110mm) 
Focus Depth = 2.000000 
Field Width = 110.000000 
Field Height = 110.000000 
Field Side = 110.000000 
Conversion = 60366 
Corr OfsX = 0 
Corr OfsY = 0 
Corr ScaleX = 1.000000 
Corr ScaleY = 1.000000 
Corr ThetaX = -26.000000 
Corr ThetaY = 35.000000 
Corr File = Corr001.cor 
 
When a new calibration is performed the corr*.cor file will be replaced. Make a backup copy of COR 
file in case of PC replacement or application program re-installation 
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Practice exercises 
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Exercise 1 -Project for engraving on different levels 
 
The figure below shows a job which entails movement of the three mechanical axes for engraving the 
piece in three different positions. 
 
 

 
 

 
The proposed exercise involves creating a project with a sequence of three different engraving items 
on the plain (laser) separated by the axis movement function. 
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• Creation of a new  Project File > New > Project 
• Addition of three jobs for plain engraving  Project> Add Plain 
• Position three functions for axis movement Project > Shift axes 
• Position three axis Shift function as shown in the figure using the arrow keys  c b 
 

 
 
Set the shift value along axes X, Y, Z for each “Axis Shift” function in the project sequence. 
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Important - Read carefully: 
This End User License Agreement is a legal agreement between you (either an individual or a single 
entity) and LASERVALL S.p.A. (hereinafter "LASERVALL") for a LASERVALL software product, 
including software, the associated media, any printed materials and any "online" or electronic 
documentation (hereinafter generally denominated "software product"). 
By installing, copying or otherwise using the software product, you agree to be bound by the terms of 
this License Agreement. 
 

Software product license 
The software product is protected by copyright laws and international copyright treaties, as well as any 
other intellectual property laws and treaties. The software product is licensed not sold. 
 

1. Grant of license 

Software. 
You may install and use one copy of the software product on a single computer, or in place of a 
previous version destined for the same operative system. The original user of the computer on which 
the software is installed has the right to create a second copy for his own exclusive use on a home 
computer or portable computer. 

Storage/Network use. 
You may also store or install a copy of the software product on a storage medium, such as a network 
server, to the extent that such is used exclusively for installing or using the software product on your 
internal network. However, you must acquire and dedicate a license for the software program for each 
computer on which the software program is installed or to which it is distributed. A license for the 
software program may not be shared or used concurrently on different computers. 

License package. 
If you acquired the present License Agreement as part of a LASERVALL license package you will be 
entitled to create other copies of the software product in the authorized number according to the 
printed copy of the present License Agreement. You can use each copy in the manner indicated 
above. You also are entitled to produce a corresponding number of copies for use on a home 
computer or portable computer in conformity with the above mentioned clauses. 
 

2. Description of other rights and limitations 

Limitations on reverse engineering, decompilation and disassembly. 
You may not reverse engineer, decompile or disassemble the software product, except and only to the 
extent that such activity is expressly permitted by applicable law notwithstanding this limitation. 

Separation of components. 
The software program is licensed as a single product. Its component parts may not be separated for 
use on more than one computer. 
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Rental. 
You may not rent or lease the software product. 

Software transfer. 
You may permanently transfer all of your rights under this Agreement only as part of a sale or transfer, 
provided that you retain no copies, transfer all of the software product (including all component parts, 
the media and the printed materials, any upgrades, The Agreement and, if applicable, the 
Certificate(s) of Authenticity and the recipient agrees to the terms of this Agreement. If this software 
product is an upgrade, any transfer must include all prior versions of the software product. 

Termination. 
Without prejudice to other rights, LASERVALL may terminate this Agreement if you fail to comply with 
the terms and conditions of the Agreement. In such event, you must destroy all copies of the software 
product and all of its component parts. 
 

3. Upgrades 
If the software product is an upgrade from another product, whether from LASERVALL or another 
supplier, you may use or transfer the software product only in conjunction with that upgraded product, 
unless you destroy the upgraded product. If the software product is an upgrade of a LASERVALL 
product, you may use that upgraded product only in accordance with this Agreement. If the software 
product is an upgrade of a component of a package of software programs which you licensed as a 
single product, the software product may be used and transferred only as part of that single product 
package and may not be separated for use on more than one computer. 
 

4. Copyright 
All title and copyrights in and to the software product (including but not limited to any images, 
photographs, animations, video, audio, music, text and "applets", incorporated into the software 
product), the accompanying printed material, and any copies of the software product, are owned by 
LASERVALL. The software product is protected by copyright laws and international treaty provisions. 
Therefore you must treat the software product as any other type of material covered by copyright, with 
the exclusion that you either (a) create a single backup copy of the software product to be used 
exclusively for backup and file requirements; or (b) install the software product on a single computer if 
the original is kept for backup and file requirements. You may not copy the printed materials 
accompanying the software product.  
 

5. Dual-media software 
You may receive the software product in more than one medium. Regardless of the type or size of the 
medium you receive, you may only use one medium that is appropriate for your single computer. You 
may not use or install the other medium on another computer. You may not loan, rent, lease or 
otherwise transfer the other medium to another user, except as part of a permanent transfer (as 
provided above) of the software product. 
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6. Warranty conditions 

Limits of the warranty. 
LASERVALL guarantees for a period of 90 days from the date of delivery to customer that (a) the 
medium/media on which the product is supplied is free from material defects, (b) under normal use it 
functions in conformity with that described in the accompanying manual. LASERVALL supplies this 
guarantee as producer of the software. The present provisions do not limit or substitute possible 
guarantee rights or legal responsibility towards retailers from whom the user purchases the software. 

Customers' rights. 
In the case of guarantee claim the customer has the right, at the discretion of LASERVALL, (a) to 
restitution of the price paid; or (b) substitution or supply of the missing parts of software which do not 
form part of the LASERVALL guarantee provided that they are returned to LASERVALL together with 
a copy of the purchase receipt. The present guarantee is not applicable if the software fault was 
caused by accident, improper use or erroneous application. Each substitute software component is 
guaranteed by LASERVALL for the remaining period of the original guarantee and in any case for not 
less than 30 days. 

Warranty exclusions. 
LASERVALL does not recognize any other warranty relative to software and accompanying 
documentation (in printed or electronic form). 

Exclusion of liability for indirect damages. 
LASERVALL or suppliers for its products will not be liable for damages (including, without limitations, 
damages due to loss of income, interruption of activity, loss of information or data, or other economical 
damages) deriving from use of this product or from inability to use the software, even in the case that 
LASERVALL is advised of the possibility of such damages. In any case, the liability of LASERVALL 
will be limited to an amount corresponding to that actually paid for license concession. This exclusion 
of responsibility is waived for damages caused by fraud or serious fault on the part of LASERVALL. 
Rights relative to binding regulations of responsibility for the product remain unprejudiced. 
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